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FileNet Document Publisher Introducing FileNet Document Publisher
CHAPTER 1

Introducing FileNet Document Publisher

FileNet Document Publisher comprises the workstation, FileNet Document Publisher 
Station, and the server, FileNet Document Publisher Server. If you have not yet 
installed and configured FileNet Document Publisher, please see the Installation 
Guide in the Documentation folder of your installed directory and also on the 
product disc.

If you have already completed the “Seven Easy Lessons,” you are probably familiar 
with the key interface elements discussed here. In that case, you may want to just 
skim the contents of this chapter and move on to Chapter 2, which explains how 
FileNet Document Publisher works. 

In this chapter, you will 

Learn how to launch FileNet Document Publisher 

Become familiar with the Startup Screen

Review the main window in FileNet Document Publisher, including the menu 
bar, standard toolbar, and large toolbar

Launching FileNet Document Publisher 
Once you have installed FileNet Document Publisher, you can launch the web 
publishing tool in a number of ways:

Choose Programs from the Start menu in Microsoft Windows, select the 
FileNet Document Publisher program group, and click FileNet Document 
Publisher Station. 

Choose the Run command from the Start menu and type the full path and 
name of the executable file, in quotes, in the text box (for example, 
"C:\Program Files\FileNet Document Publisher\Transit.exe").

Double-click the executable file Transit.exe in Windows Explorer.

Double-click the shortcut icon on the desktop (if you have set one up).

However you choose to launch it, FileNet Document Publisher opens initially with an 
About Box, which appears briefly on top of the FileNet Document Publisher main 
window before being replaced by the Startup Screen. 

Startup Screen
The Startup Screen (see Figure 1-1) provides alternative ways to start a new project 
and open an existing one. It also offers three learning opportunities:

Wizard — Opens the Add a Document wizard, which walks you through the 
basic steps required to turn a source document into a web page. 

Seven Easy Lessons — Opens a series of lessons (in PDF) that provide a 
quick introduction to the basics of using FileNet Document Publisher. 
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Tutorial — Opens a second, more advanced series of lessons (also in PDF) 
that build on what you have learned in “Seven Easy Lessons.” (You do not have 
to complete “Seven Easy Lessons” before tackling the Tutorial, but we 
recommend that you do.) 

Once you select an option in the Startup Screen, you will not return to this screen 
during your current session in FileNet Document Publisher. Rather, you will 
complete project setup in the main window, using the commands available there. 

You can click Cancel to bypass the Startup Screen, if you prefer, and open a new or 
existing project directly from the File menu. You can also click Don’t show this 
screen again if you do not want the screen to be available for future sessions. (To 
return to the screen at any time, choose Show Startup Screen from the Help menu.)

Figure 1-1  The Startup Screen, which can be opened from the Help menu at any time. 

FileNet Document Publisher main window
The tools you use to set up publications for translation reside on the menu bar, the 
standard toolbar, and the large toolbar of the main window (see Figure 1-2). The 
menu bar contains all of the commands in FileNet Document Publisher, and the 
standard toolbar contains most of them. The large toolbar, which offers only key 
commands, may be especially useful when you start using the application, since you 
can quickly identify each button. Let us review all the commands. 

Menu bar
To open a menu, click the menu name. You can then click any command from the 
drop-down list of commands. You can also use keyboard shortcuts to open menus 
and activate their commands. 

The File menu provides commands to open new and existing project files, to 
save project files, to open the Folder Import wizard, to import and export 
publications, and to exit FileNet Document Publisher. The last four projects you 
have worked on are listed at the bottom of the menu. 
6
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You can use the Folder Import wizard (click Import to start the wizard) to add a 
portion of the directory structure of your file system to the publication 
hierarchy of your project. You can import the directory structure and the 
individual files in the folders or treat the folders as Directory Items when you 
import them. (See Chapter 4 for more information on Directory Items and the 
Folder Import wizard.)

The Edit menu provides Windows edit commands: Cut, Copy, Paste, and 
Delete.

Figure 1-2  The FileNet Document Publisher main window, with the menu bar, standard toolbar, and 
large toolbar. The Publication Hierarchy pane displays the root publication and any subpublications, while 
the Contents pane shows details of the publication selected in the Publication Hierarchy pane.

From the View menu, you can view the translation log file and open any source 
document selected in the Contents pane in its native format. (In the case of a 
source document from FileNet Content Manager or FileNet Content Services, a 
message will appear, asking whether you want to preview a read-only copy or 
check out the source document in its native format.) You can also open the 
Application Options and Project Options dialog boxes. The latter contain a 
variety of options for such settings as logging level and the output page naming 
convention you want to use. (They are discussed in detail in Chapter 6.) Finally, 
you can open the Toolbars submenu, which lets you show or hide the status 
bar and both toolbars, as well as customize the standard toolbar.

From the Add menu, you can add a document, a reference page, a 
publication, or a Directory Item. When you add a Directory Item from the file 
system, individual source documents of a specified format automatically 
become a part of the translation process when they are added to the selected 
directory. When you add a Directory Item from FileNet Content Manager or 
FileNet Content Services, or from an FTP or HTTP site, you must use the 
Update Versions command before translating. However, if you are using FileNet 
Document Publisher Server, it does not matter where the Directory Item is 
from—the Server will automatically update the Directory Item before 
translating and publishing the project. (See Chapter 4 for more on Directory 
Items.)

From the Publication menu, you can open the Layout dialog box, where you 
can create a frameset or table layout for your publication. You can also add 
7
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associated files (which become an integral part of your project and are 
processed by FileNet Document Publisher during translation) and open the 
Publication Properties dialog box. All three commands are also available from 
the popup menu that appears when you right-click a publication in the 
Publication Hierarchy pane. 

The Template menu provides access to the four template editing options: 
Element Setup, Formatting, Navigation, and Globals. You can also open the 
Choose Template, Edit Template, and Manage Templates dialog boxes. 

From the Run menu, you can translate source documents. The Translate 
command runs an incremental translation. Typically, this is what you will want 
to do most of the time as you create and fine-tune your web publications. (The 
command is also on the standard and large toolbars). The Translate All 
command runs a complete translation (which you can also accomplish by 
deleting all your output files or changing your output directories). With the 
Translate Selected command, you can translate a selected portion of your 
publication. (First select one or more files in the Contents pane before choosing 
the command, which is also available by right-clicking the selected files to open 
a popup menu. Choosing the command opens the Selective Incremental 
Translation dialog box.)

The Run menu also contains five commands that come into play when you use 
Document Publisher Station with Document Publisher Server: Update Versions, 
Stage, Staging Options, Publish, and Publishing Options. Update Versions is an 
important command for updating your source documents before translation (it 
can also be used to update source documents from an FTP or HTTP site). The 
Stage command is used to “stage” your final output to a repository, so that you 
can review and approve your web publication before publishing live to your 
web site, using the Publish command. (See Chapter 5, “The Publishing 
Process,” for more information on staging and publishing.)

The Viewers menu enables you to launch the default web browser associated 
with Document Publisher Station and to associate additional viewers with the 
program. The viewers can include utilities such as Notepad as well as browsers. 

The Server menu lets you move project files to a network location (by using 
the Project Export wizard) and schedule the automated translation of projects 
(by using Document Publisher Scheduler to connect to Document Publisher 
Server). 

The Help menu provides access to the comprehensive online Help system, to 
the “Seven Easy Lessons” and the Tutorial, and to product and copyright 
information.

Once you have opened an existing project or created a new one, and completed 
setup, you will spend most of your time using the four template editing commands 
available from the Template menu and standard toolbar. These commands are also 
available from the Edit Template dialog box. Project setup issues specific to using 
FileNet Content Manager or FileNet Content Services with FileNet Document 
Publisher Server are discussed in “Project setup in a FileNet repository” on 
page 35.
8
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Standard toolbar
Buttons on the standard toolbar mirror most of the commands available from the 
menu bar. The standard toolbar can be seen as a set of smaller toolbars, set off 
from each other by separators. As you pass your cursor over the toolbar, a tooltip 
will explain each command.

Figure 1-3  The standard toolbar.

You can use drag-and-drop to position the toolbar anywhere on the desktop. You 
can also resize the toolbar with your mouse (see Figure 1-4). To remove any 
command from the toolbar, select the icon, hold down the Alt key, and drag the icon 
off the toolbar. To customize the toolbar, click Toolbars on the View menu and 
choose Custom from the submenu. 

Figure 1-4  The standard toolbar, shown here as a toolbox. The vertical separators ensure that related 
icons stay together when the toolbar is resized.

Large toolbar
The large toolbar down the right side of the main window (see Figure 1-5) is similar 
to the standard toolbar below the menu bar, but it contains only the main 
commands you are likely to use in FileNet Document Publisher Station. Since the 
buttons are labeled, new users may find this toolbar useful at first. (To hide the 
toolbar, choose Large Toolbar from the Toolbars submenu of the View menu.) 
9
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Figure 1-5  The large toolbar, which you can hide or show at any time by choosing Large Toolbar from 
the Toolbars submenu of the View menu. You can also drag and drop the toolbar on the desktop. 

Popup menus
Throughout FileNet Document Publisher there are many opportunities to right-click 
in order to open a popup menu with a selection of commands appropriate to where 
you are in the interface. For example, when you right-click a source document in the 
Contents pane of the main window, the following popup menu appears:

Figure 1-6  Popup menus can be opened from different parts of the interface. The commands 
available will vary, depending on where you are in the interface and what you right-click.

There are many “right-click opportunities” in Document Publisher Station to help 
you speed up the execution of commands.

Help
Also available throughout Document Publisher Station are numerous Help buttons, 

which can be found on most of the property sheets and dialog boxes: 
10
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Clicking a Help button will open a topic in the Help system that is specific to the 
property sheet or dialog box you happen to be working in. Remember, too, that you 
can always choose Help Topics from the Help menu to gain access to all of the 
topics in the Help system.

About the Help system
FileNet Document Publisher provides a Help system that consists of individual Help 
topics in HTML (HyperText Markup Language) format. You can view the Help system 
in a web browser such as Internet Explorer or Netscape Navigator (see figure), and 
you can use conventional web browser controls to navigate and view the Help topics 
(Back, Forward, Refresh, and so on).

Figure 1-7  Online Help in FileNet Document Publisher

You can open Help by clicking Help > Help Topics in Document Publisher Station. 
Each dialog box in Document Publisher Station (as well as Document Publisher 
Scheduler and Document Publisher Server) has a Help button as well that takes you 
directly to a topic that describes the functionality of the dialog box. You can gain 

access to the rest of the Help system by clicking the Show Navigation  button 
in the navigation bar above the Help pane. (This button only appears when you 
open Help topics from a Help button.)

The online Help contains the following navigation options:

Contents: The Contents tab contains an expandable list of Help topics. Click a 
book icon to expand or collapse that section of the Help system and then 
select the desired Help topic to view a topic.

Index: The Index tab provides immediate access to individual Help topics by 
keyword.

Search: The Search tab provides a full-text search of the Help system. Type the 
word or phrase you are looking for and then click Go (or press Enter on your 
keyboard).

Favorites: The Favorites tab provides a means to save topics that you have 
found useful and anticipate viewing again. (When viewing such a topic, click 
Favorites and then click Add to add the topic to your Favorites list.) 

Note: The Favorites tab does not display if your browser does not support the 
Java applet used by the Help system.

The online Help also includes a toolbar with the following options:
11
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Notes

The FileNet Document Publisher Help system uses a secure Java applet to 
display the Contents, Index, Search, and Favorites tabs. If the Java applet is 
not installed or enabled in the web browser used to view Help, a JavaScript 
rendition of Help will display, instead. If both Java and JavaScript are disabled 
in the web browser, the browser will not be able to display Help.

The Java applet is not supported by Internet Explorer on UNIX, Netscape 4.x 
on Macintosh, Netscape 6.x on any platform, or by any machine running a 
newer version of the Java Runtime Environment (JRE) 1.3.1_02. For these 
browsers and operating systems, the JavaScript rendition of Help displays 
(assuming it is not disabled in the browser).

If you are running Windows XP Service Pack 2 and open Help from FileNet 
Document Publisher, you may not see its contents because the Information Bar 
in Internet Explorer prevents you from viewing active content. This is because 
the Help system uses client-side JavaScript to display the Contents pane. To 
view the Help system, click on the Information Bar and choose Allow Blocked 
Content (see figure).

For more information, see Internet Explorer Help.

Toolbar Definition

Highlights the title of the topic currently being viewed in the Contents tab. If you open a Help 

topic by clicking the Help button in a dialog box, the Show Navigation button  will 
appear, instead.

Displays the topic that precedes the currently displayed topic. (The order of topics can be 
seen on the Contents tab.)

Displays the topic that follows the currently displayed topic. (The order of topics can be seen 
on the Contents tab.)

Opens a new, blank email message with the name of the Help topic in the Subject line, 
addressed to FileNet Technical Support. Please use this feature to provide feedback to 
FileNet on the topic itself or how the topic is documented.

Prints the currently displayed topic by using your web browser print feature.

Opens a PDF version of the Getting Started (this manual).

Connects to the FileNet web site (www.filenet.com), where you can learn more about FileNet 
products, upcoming events, and technical support.
12
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CHAPTER 2

How FileNet Document Publisher works

If you have completed the “Seven Easy Lessons,” you already know how easy it is to 
create a simple web publication in FileNet Document Publisher, one consisting of a 
single source document that becomes a single web page. Before you tackle more 
sophisticated publications—consisting of a fully linked set of web pages created 
from multiple source documents—you should become familiar with the key concepts 
outlined in this chapter.

A simple web publication
Figure 2-1 shows web publishing with FileNet Document Publisher in its simplest 
terms. You can see how a source document created in a word processor, which 
traditionally might be printed from a laser printer or by other conventional means, 
can easily be imported into FileNet Document Publisher and re-purposed for 
viewing on a web server. 

To accomplish this in FileNet Document Publisher, you would:

Start a new project

Create a new publication

Select a source document from your file system (or from a FileNet repository)

Associate a template with that document 

Import styles or patterns from the document, or ask FileNet Document 
Publisher to apply ranks

Format the elements associated with those styles, patterns, or ranks

Translate the document to turn it into a web page

All of this can be done with surprising ease in Document Publisher Station.

Figure 2-1   Print documents can easily be repurposed for publishing on an intranet.
13
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More options
Thanks to the power of FileNet Document Publisher, you can just as easily handle 
more complex projects. For example, to create a more sophisticated web 
publication, you could

Include numerous source documents in a variety of file formats in your project

Obtain these source documents just as easily from a repository such as FileNet 
Content Manager or FileNet Content Services, or an FTP or HTTP site

Build a reference page, such as a table of contents, or key word index, to aid 
navigation and information retrieval 

Associate different templates with different types of source documents and 
reference pages to create a special look for each topic area

Build a publication hierarchy by adding publications to the root publication and 
then adding source documents and reference pages to each publication 

Add a Directory Item to a publication, to let content authors drop documents in 
a specified format into that directory and to have those documents 
automatically translated to become a part of your web publication

Create a frameset or use tables or custom tables to help structure your web 
publication and treat special content in consistent ways

Turn a regular project into a master project by including a linked publication as 
a subpublication in the master project’s publication hierarchy

Figure 2-2  With different templates you can fine-tune the look and behavior of source documents in 
your project and publish to a web server, whether for an intranet, extranet, or Internet site.

Working with a FileNet repository
When FileNet Document Publisher is used with FileNet Content Manager or FileNet 
Content Services, even more options are available to you. You can

Take advantage of FileNet Document Publisher’s dual-publishing capability to 
first stage your output for review and approval before you publish it to your 
web site
14
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Place document information from FileNet Content Manager or FileNet Content 
Services in the output web pages you create

Project setup
However simple or complex your web publication, there are certain key stages in 
the process of creating that publication. Much of what you do in Document 
Publisher Station during the preliminary stage of project setup is related to creating 
one or more templates to capture a variety of formatting and other instructions that 
determine the look and behavior of your web publication onscreen. All that 
information is saved (with other information) in a project file that can be opened at 
any time so that you can quickly re-create your publication or edit the templates. 

Project setup is discussed more fully in Chapter 4, “Project setup in a FileNet 
repository,” especially in the context of taking source documents from a FileNet 
repository. For now, let us review what happens each time you add a source 
document to a project in FileNet Document Publisher (whether from the file system 
or FileNet Content Manager or FileNet Content Services). The content of those 
documents is, after all, what concerns you the most.

Ranks, styles, and patterns 
When you select a source document—that is, add it to your project—the first thing 
you must do is associate a template with that document. (As soon as you add the 
document, Document Publisher Station automatically opens the Choose Template 
dialog box. It is not critical which template you initially associate with the source 
document, because you can return to this dialog box at any time and choose 
another template instead.)

When you select a template, you must also decide which setting you want to use 
under Import Styles or Patterns. With the default setting None, Document Publisher 
Station creates a default set of ranks that are applied to content at translation time 
to ensure that top-level hierarchy is always treated consistently, even when the 
source documents are inconsistently formatted. Document Publisher Station creates 
an element for each rank and places those elements in the template. If you select 
Styles or Patterns instead, Document Publisher Station proceeds to import styles or 
patterns from the source document and automatically generates an element for 
each style or pattern and places those elements in the template, instead. 

Thereafter, all editing begins by first selecting the template in the Contents pane of 
the main window and choosing one of the template editing options. In most cases, 
you then select one or more elements to apply precise settings to specific portions 
of the document’s content.

During translation, Document Publisher Station takes the content of each source 
document, reformats it per your instructions in the template and elements, and 
produces an HTML file, which it places in an output directory. This file is the web 
page you view in a web browser. Your source documents remain unchanged. And 
you can update each web page of your web publication repeatedly with push-button 
simplicity whenever you revise the appropriate source document. 

So one of the keys to FileNet Document Publisher is understanding the power and 
flexibility of templates and elements. Once you have gone through the initial phase 
of setting up a project, you are ready to tap this power and flexibility to create the 
exact look and feel that you want for your web pages. 
15
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Templates and elements
A template in FileNet Document Publisher is similar to a template in a word 
processor. It contains formatting instructions that determine how your source 
document will look when turned into a web page and viewed in a web browser.

In Document Publisher Station, you can always “pass through” a source document 
and its formatting, based on its existing styles. In other words, you can translate the 
document without changing the elements. You may, in fact, want to do this each 
time you create a new publication and translate its source documents for the first 
time. (To do so, simply associate the source documents with the Blank template in 
the Choose Template dialog box.) However, the power of FileNet Document 
Publisher resides in your ability to not only reformat the original attributes of any 
style (font, size, etc.), but to use templates and elements to shape the hierarchy of 
a document and to make its content accessible to users in different ways. 

You can use elements to place content in different reference pages or suppress it 
entirely from a web page; create button and text bars for navigation; create links 
between different portions of a source document; embed HTML or scripting code in 
portions of the content; and much more. In short, elements allow you to treat 
individual portions of the content in special ways. 

As a result, you could have two templates that contain a duplicate set of elements 
that mirror the styles of a particular document. If you format the two templates 
differently, you can switch templates at any time to produce a dramatically different 
result in the web page you create when you translate the document. All this 
information is captured in a template, which, in turn, is captured in the project file 
unique to each publication.

The project file
When you create a project, you will likely want to preserve all the important details 
of the project so that you can update it at any time. FileNet Document Publisher 
simplifies the management of web publications by allowing you to capture important 
information about each project in its own project file. 

Each time you begin a new project, you open a copy of the default project file, 
Default.tcp. “Unsaved” appears in the title bar. (You can choose Save As from the 
File menu to name the file and save it to whatever directory you want.) 

With the project file, you capture information about

the publication hierarchy, consisting of the root publication and all 
subpublications at levels below the root publication

each publication in the hierarchy in terms of its source documents, output 
pages, optional reference pages, the template associated with each document, 
and also the frameset (if any) that is associated with the publication

special subpublications that consist of Directory Items or linked publications

output directories

any global instructions that apply to the web publication as a whole

If you use the same setup for source documents and output directories each time, 
updating an archived web publication is easy. You simply revise the content of a 
source document, open the project file for the publication that contains that 
document, and retranslate. (If you choose FileNet Document Publisher’s incremental 
translation option, FileNet Document Publisher detects which source documents 
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have changed since the last translation and translates only those. You will want to 
choose the Update Versions command first.) 

Note: The default name for a new project, “Unnamed,” appears at the top of the 
Publication Hierarchy pane and also above the Contents pane. You can use the 
same name for both the root publication and the project file, if you want. To name 
the root publication, right-click the publication and choose Properties from the 
popup menu, and enter a new name in the Publication Name text box.

Key terms
Below is a list of key terms used in FileNet Document Publisher. These terms are 
essential to your understanding of FileNet Document Publisher if you are to use the 
web publishing tool to full advantage. 

project — The overall term for the web publication you create that encompasses 
the project file, its templates, and all source documents, related graphics, and 
associated files.

project file — What you need to begin a new project. Document Publisher Station 
starts with a copy of the default project file already open (“Unsaved” appears in the 
title bar). You use a project file to save important details about a project, including 
the publication hierarchy, the location of source documents, the template 
associated with each document, and the location of output directories for the HTML 
files produced during translation. (Document Publisher Station automatically zips 
your project file each time you save it in order to compress it. The .tcp extension 
remains unchanged.)

Default.tcp — The default project file that is installed in the ..\Resource\en folder of 
the FileNet Document Publisher directory. Document Publisher Station opens a copy 
of Default.tcp each time you start a new project. You can edit Default.tcp, if you 
want, to customize the templates or settings you want available each time you start 
a new project. 

DefaultWML.tcp — The default project file used to create WML projects, also 
available in the ..\Resource\en folder in the FileNet Document Publisher directory. 
(Copies of both default project files are on the product disc.)

master project — The same as a regular project except that it contains one or 
more linked publications; that is, one or more subpublications in the project’s 
publication hierarchy contain a link to another project file.

linked publication — A publication with its own project file that is linked to an 
existing project, which becomes the master project, as a result. You must open the 
linked publication by itself in Document Publisher Station in order to edit it. Once 
the linked publication is edited, you can update it within the master project by using 
the Update Versions command.

project author — The individual responsible for a project, that is, for creating the 
project and templates, setting staging and publish options, and so forth.

content author — The individual responsible for creating the source documents 
that reside in a repository (typically, FileNet Content Manager or FileNet Content 
Services) and are the proposed content of your web site.

webmaster — The individual responsible for reviewing a project on the staging area 
and for authorizing its final approval and release to the web site (publishing area). 

source document — The content you want to translate into HTML format and 
display in a web browser. FileNet Document Publisher can convert source 
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documents in over 225 formats. (The major ones are listed in Appendix A, “File 
formats and translation” on page 84.) Once you translate each source document, it 
becomes a web page for viewing in a web browser. 

publication — a container for the source documents that you want to translate and 
any reference pages you want FileNet Document Publisher to build. 

Each new project has a root publication. (Its default name, “Unnamed,” appears at 
the top of the Publication Hierarchy pane. To name the root publication, right-click it 
and choose Properties from the popup menu.) You can create a publication 
hierarchy by adding publications to the root publication, publications to those 
publications, and so on. (Each publication, when added to another, becomes a 
subpublication.)

Whatever the publication—the root publication itself or one of its subpublications—
it should be a logical entity that reflects a natural grouping of content, to which you 
can add frames, tables, reference pages, etc., to reinforce that content. 

publication hierarchy — What is visible in the Publication Hierarchy pane, that is, 
the root publication and all subpublications at all levels. Each project in FileNet 
Document Publisher consists of at least a root publication. But you can add 
publications to the root publication, and publications to those publications. When 
you select a publication in the Publication Hierarchy pane, its contents display in the 
Contents pane. You can view the contents of only a single publication at a time in 
the Contents pane.

web publication — What you create in Document Publisher Station for viewing in a 
web browser. At its simplest level, a web publication consists of a single web page 
(from the translation of a single source document). But a web publication typically 
will comprise many web pages, including reference pages such as a table of 
contents (TOC). Moreover, the publication hierarchy can be quite sophisticated, 
consisting of many publications at different levels, each one containing its own 
source documents and reference pages, with some of its subpublications 
representing a Directory Item or a linked publication.

web page — The smallest unit of a web publication, which may reside in a single 
frame of a frameset. FileNet Document Publisher creates two kinds: body page and 
reference page. 

body page — What you create each time you translate a source document. Body 
pages correspond to the content of source documents and are the main output of 
translation. Each one is an HTML file. (If your source document contains embedded 
or linked graphics, FileNet Document Publisher converts them into individual 
graphics files, in the GIF, JPEG, PNG, or BMP format. So a body page may have 
related graphics files.) 

reference page — An optional page built during translation. Reference pages 
derive their content from body pages and are automatically linked to them. There 
are four types: publication Table of Contents (TOC), List of Tables (LOT), List of 
Figures (LOF), and Index. Each one is an HTML file. (Note: The TOC you place at the 
beginning of body page is a “page TOC” and is a part of the same HTML file as the 
body page. Its contents typically differ from the contents of the publication TOC.) 

Directory Item — A directory or folder that you have added to a project in FileNet 
Document Publisher so that source documents placed in the directory at any time 
become part of the project. 

In the file system, on an FTP site, or in FileNet Content Manager or FileNet Content 
Services, you can also create a dynamic Directory Item, whereby FileNet Document 
Publisher incorporates into a project not only the identified folder (directory), but all 
the folders below that folder in the system hierarchy. In addition, with a FileNet 
repository you have the option of using a stored search for a Directory Item.
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Whether the Directory Item is based on the file system hierarchy, an FTP or HTTP 
site, or a folder or stored search in FileNet Content Manager or FileNet Content 
Services, you must use the Update Versions command before you translate. 
However, updating is automatic when you schedule projects for translation by 
Document Publisher Server, because the server automatically updates Directory 
Items before it translates projects. 

repository — A place where electronic files are stored. Usually implies that access 
to the files in the repository, and the use of those files, is controlled. In FileNet 
Document Publisher, the file system, an FTP site, an HTTP site, and FileNet Content 
Manager and FileNet Content Services are all referred to as “repositories.”

stage / staging — Part of the dual-publishing option in FileNet Document 
Publisher. When Document Publisher Station or Document Publisher Server stages a 
project, this means that the translated output is copied from the file system to a 
staging area so that the contents of your web publication can be formally reviewed 
and approved before being published. 

publish / publishing — Part of the dual-publishing option in FileNet Document 
Publisher. When Document Publisher Station or Document Publisher Server 
publishes a project, this means that translated output is copied from the file system 
to a publishing area—in effect, your web site. Typically, you will want to stage your 
project before you publish it (go live on your web site). But you can publish without 
staging (and stage without publishing). 

web site — Where you publish your web publication. Referred to also as the 
publishing area or location.

frameset layout — One of three layout options in FileNet Document Publisher. 
With frameset layout, you create a set of frames that help you organize content for 
viewing in a web browser. In FileNet Document Publisher, all body pages must 
display in a single frame of any frameset you use. But other frames can contain 
graphics, TOCs, and other types of reference pages. They can also be used to target 
URLs, HTML code, or JavaScript. You can use the same frameset for all the 
publications in the publication hierarchy of a given project or a different frameset for 
each one. 

table layout — One of three layout options in FileNet Document Publisher. With 
table layout, you can create a structure of cells instead of frames to organize your 
content for viewing in a web browser. All body pages must display in a single cell of 
any HTML table that you create. But other cells can contain graphics, TOCs, and 
other types of reference pages. They can also be used to target URLs, HTML code, 
or JavaScript. You can use the same table layout for all the publications in the 
publication hierarchy of a given project or a different table layout for each one.

custom table layout — One of three layout options in Document Publisher Station. 
This option is especially useful if you are creating your web site look and feel in a 
third-party HTML editor such as Macromedia Dreamweaver or Microsoft FrontPage.

template — A key feature in FileNet Document Publisher, similar to a word 
processing template, that allows you to capture all the formatting instructions 
associated with a document. Most of these instructions are associated with the 
individual elements that the template contains (some are associated with the 
template itself). 

You can associate only one template with a given document, but the same template 
can be associated with many different documents. Templates are saved as part of 
the project file and typically do not exist as separate files. But you can create a 
template file, if necessary, to export a template for use in another publication. You 
can also place a template file on a network and establish a link to that template 
from any FileNet Document Publisher workstation connected to the network. 
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Multiple users can link to the template at the same time. (You must import a linked 
template into FileNet Document Publisher in order to edit it.)

A template associated with a source document is sometimes referred to as a body 
page template, to differentiate it from the special reference page template you 
associate with a reference page.

Element — Another key feature of FileNet Document Publisher. When you import 
styles or patterns from a source document, Document Publisher Station generates 
an element for each style or pattern. (If your document contains a style named 
Heading 1, Document Publisher Station creates an element named Heading 1.) 
Likewise, if you choose ranks, Document Publisher Station will create an element for 
each rank (which will be applied at translation time). Once Document Publisher 
Station creates an element for each style, pattern, or rank, you can use these 
elements to format your source documents.

Elements reside in a template. Their names are displayed in an Elements list found 
in many of the tab dialogs. Each element represents corresponding content in the 
source documents. As you format the element, you are setting formatting 
instructions for all content that corresponds to that element. You can select multiple 
elements and format them as a group. 

style — There are two kinds of styles in FileNet Document Publisher: paragraph and 
character. A paragraph style is a set of formatting characteristics that are saved and 
given a name so that the style can be applied to any paragraph in a source 
document. Typical styles in a word processing file are Normal, Heading 1, and 
Footer. FileNet Document Publisher imports named styles from a source document 
and generates an element for each style. You format content by formatting the 
elements to turn the document into a web page. You use mostly paragraph styles to 
create web pages.

A character style is where selected subject matter within a paragraph has been 
assigned formatting attributes different from the paragraph style. The formatting of 
a character style overrules the subject matter formatting of the paragraph style. 
Word processor programs often contain built-in character styles such as Annotation 
Reference and Footnote Reference. 

pattern — In many instances organizations have manually formatted documents. 
FileNet Document Publisher can handle such documents by recognizing patterns in 
how the font attributes have been set. Say your source document is set totally in the 
Normal style, with two major headings set in 16-pt bold and 12-pt italic, 
respectively. And let us assume that no other text uses these font attributes. In that 
event, FileNet Document Publisher will recognize the font attributes of these 
headings as patterns and assign pattern names to them (and probably create the 
elements Heading 1 and Heading 2 for the headings and assign the Default 
Paragraph element to all other content). Once FileNet Document Publisher assigns 
elements to those patterns, you can edit the elements to format your document. 
(FileNet Document Publisher can also handle text documents, which are completely 
unstyled, but your formatting options here are obviously limited.)

Like styles, you can have paragraph patterns and character patterns. Character 
patterns can be useful for isolating specific text or data within a paragraph that you 
want to treat in a special way. Many templates in the default project file contain 
three standard character patterns that can be particularly useful: HTTP, WWW, and 
Email.

rank — Serves as a way to recognize the content hierarchy of a document. Can be 
especially useful when you are importing a variety of source documents where some 
contain named styles and others have manually formatted content, or where styles 
have been inconsistently applied. Rather than import styles or patterns, FileNet 
Document Publisher creates a default set of ranks, which it applies to content at 
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translation time to ensure that the top-level hierarchy of the documents is treated 
consistently. Ranks can be especially useful where you are translating legacy 
documents or have added a Directory Item to your project. 

Note: In the Choose Template dialog box, the default setting under Import Styles or 
Patterns is None. This means that Document Publisher Station will use a default set 
of ranks rather than import styles or patterns. You must formally select Styles or 
Patterns in order to import styles or patterns.

metadata — Information associated with a source document, such as the author’s 
name, the document’s title, and the document’s date of creation. FileNet Document 
Publisher recognizes three kinds: repository (which you assign to a document when 
you check it into FileNet Content Manager or FileNet Content Services), and 
standard and custom (which are created in the application used to create the source 
document). Unlike styles, patterns, and ranks, metadata are not automatically 
associated with elements. But you can make any metadata element-based and then 
place that element in your web pages and publish the element to your FileNet 
repository.

What’s next
Now that you understand some of the key concepts and terms used in FileNet 
Document Publisher, you are ready for Chapter 3, which explains how to use FileNet 
Document Publisher Server to automate the publishing process, and Chapter 4, 
where you will explore project setup when using FileNet Document Publisher with 
FileNet Content Manager or FileNet Content Services. 

Chapter 5 explains the publishing process, including the dual-publishing model 
(staging and publishing). Chapter 6 examines project and application options.
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CHAPTER 3

Scheduling projects on FileNet 
Document Publisher Server

When you create projects in FileNet Document Publisher, you have the option of 
translating those projects manually in FileNet Document Publisher Station or using 
FileNet Document Publisher Server to automate the translation process and gain 
greater control over your Web publishing efforts. With the utility FileNet Document 
Publisher Scheduler, you can schedule projects to run on the Server at any time, as 
long as the Server has access to the FileNet repository where the project file and all 
source and associated files reside.

Document Publisher Scheduler is installed with Document Publisher and can be 
opened from the workstation at any time. If you install Document Publisher Server 
on a dedicated server machine, Document Publisher Scheduler is also installed. In 
that event, you can open Scheduler from the Windows program group or by double-
clicking TCScheduler.exe in the installed directory. 

Figure 3-1 shows how Document Publisher Scheduler allows Document Publisher 
Station to communicate with Document Publisher Server. As you schedule each 
project, that project becomes part of a task list in Document Publisher Scheduler. 
The log file shown is the one generated for server activity, not from translating 
projects on the task list. (See Chapter 6, “Setting project and application options.”)

Figure 3-1  The various components of FileNet Document Publisher. Source documents and 
associated files may be stored in FileNet Content Manager or FileNet Content Services, which may also 
be used for staged and published output.
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The project files you schedule—as well as all of your source documents and 
associated files—can just as easily be stored in a FileNet repository as in the file 
system. In that event, Document Publisher Server will need access to the FileNet 
repository.

Publishing in FileNet Document Publisher Server 
There is one significant difference between publishing in Document Publisher Station 
(when used as a standalone workstation) and using Document Publisher Server to 
automate the publishing process. In Document Publisher Station, four important 
commands are executed manually and separately, whereas in Document Publisher 
Server these same commands can be executed automatically, as one: Update 
Versions, Translate, Stage, and Publish. 

That is, when you schedule a project for translation by Document Publisher Server, 
the Server can automatically: 

Update all source documents at run-time (unless you have specified that 
certain versions be used),

Translate the documents, 

Copy the translated documents to the staging location (as specified in Staging 
Options), and also

Copy the translated output to the publishing location (as specified in Publishing 
Options)

Choosing your options
You do not, in fact, select Update Versions in Document Publisher Scheduler. When 
you choose the Translate command, the project is automatically updated when it 
runs at the scheduled time in Document Publisher Server. (Since updating makes no 
sense unless you also translate, updating does not occur if you simply stage or 
publish your project.)

You are unlikely to use the Stage and Publish commands together, since the point of 
staging is to review your web output before publishing (placing it directly on your 
web site). Typically, you would schedule your project just to Translate or to Translate 
and Stage. You would then schedule the same project as a separate task just to 
Publish.

For example, you might set up a task for the project to be translated and staged on 
the 4th, 11th, 18th, and 25th of each month, and also set up a separate task for 
the same project to be published on only the 1st of each month. Thus, after the first 
day of each month, you would know that you had a month to review and approve 
successive, staged versions of your project on your staging location. (Of course, you 
can only stage and publish if you have set staging and publishing options, 
respectively.)

On the other hand, if you have full confidence in your web output, you may choose 
to bypass staging altogether, in which case you would use the Translate–Publish 
sequence. (For more information on staging and publishing, see Chapter 5, “The 
publishing process” on page 57.)

Finally, you can also choose to simply update and translate. This might make sense 
if, say, the webmaster wants to wait until all content authors have submitted their 
projects for the web site and all tasks have been processed cleanly by the server. It 
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might also make sense if, say, you are still in the process of creating your project 
and it just does not make sense to stage (or publish) just yet.

Versioning the project file
In Document Publisher Station, you create a project file when you save a new file to 
FileNet Content Manager or FileNet Content Services for the first time. Thereafter, 
each time you use the Save command, you create a new version of the project file in 
the FileNet repository.

In Document Publisher Server, the project file is automatically updated just before 
translation. (If, for example, the project contains one or more Directory Items, it is 
very likely that new source documents have been added to the project since it was 
scheduled for translation.) Document Publisher Server then translates the source 
documents and saves the project file in the FileNet repository. (It may also stage or 
publish the translated output, if one of those options was selected when the project 
was added to the task list.)

When Document Publisher Server saves the project file to the FileNet repository, it 
assigns a new version number. The version numbers of a project file are only visible 
when you view the project file in FileNet Content Manager or FileNet Content 
Services. 

Connecting to FileNet Document Publisher Server 

 1.  With FileNet Document Publisher running, click Scheduler  on the toolbar 
or choose FileNet Document Publisher Scheduler from the Server menu.

 2.  In the FileNet Document Publisher Scheduler window, click Connect  on 
the toolbar or choose Connect from the Server menu, to open the Connect to 
Server dialog box.

Note: If you have previously connected to a particular server, you will 
automatically connect to that server when you start Document Publisher 
Scheduler. (The title bar will display the name of the server you are connected 
to.) If you now want to connect to a different server, use the Connect 
command.

 3.  In the text box, type in the name of the server you want to connect to, that is, 
the machine on which Document Publisher Server is running.

If you are running Document Publisher Server on your local machine and are 
not sure of the Server’s name, right-click Network Neighborhood in Windows 
Explorer and choose Properties from the popup menu. On the Identification 
tab dialog you will see the name of your machine displayed in the Computer 
Name text box.

If you are running Document Publisher Server remotely, click Browse in the 
Connect to Server dialog box to open the Browse for Computer dialog box, 
which displays the Network Neighborhood. You should see the name of the 
machine there. Select the machine from the list. (If it is not available, contact 
your network administrator.)

Note: If you are running Document Publisher Server remotely, it must be 
running in order to successfully connect to it.
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 4.  Click OK. The title bar of Document Publisher Scheduler displays the name of 
the machine you are now connected to.

Once you are connected to the machine on which Document Publisher Server is 
running, you are ready to schedule projects for translation.

Scheduling projects for translation
Scheduling a project in Document Publisher Scheduler is a two-part exercise: first 
you specify the task, and then you set the actual schedule. If you are both staging 
and publishing the project, you will likely want to schedule the project twice (using 
the first task to stage the project and the second task to publish it).

To specify the task

 1.  In Document Publisher Scheduler, click New Task  on the toolbar or 
choose New from the Task menu to open the New Task dialog box (see 
Figure 3-2).

Figure 3-2  The Specification tab dialog of the New Task dialog box in Document Publisher Scheduler. 

 2.  In the Specification tab dialog, select FileNet Content Manager or FileNet 
Content Services from the Repository drop-down list, and click Browse 
opposite the Project field to open the Select a Project dialog box.

 3.  Select the project file you want to schedule and then click Open.

The Select a Project dialog box closes, and you are returned to the New Task 
dialog box.

 4.  In the Log File text box, choose a directory and name for a log file that you 
would like to have a report of your translation written to. 

This information is from the perspective of the server machine. So if you choose 
a directory such as C:\My Documents, your log file will be written to the 
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Server’s local drive, in the directory My Documents. Choose a drive and 
directory that is accessible by both the Server and your login. You may want to 
consult your network administrator for this information. 

Use UNC paths rather than DOS paths, as these are more universal and users 
will not have to worry about whether or not they are using the same drive 
mappings as the server. 

Example: ..\News\Share might be the UNC equivalent of drive S:\.

To ensure that you use an UNC path, always use the Browse button opposite 
the Project text box to select the project file, and always start your search from 
Network Neighborhood in the Open dialog box (you can use the Look In drop-
down box to locate Network Neighborhood). Starting your search from 
Network Neighborhood will ensure that a UNC path is returned in the Project 
text box in the New Task dialog box.

 5.  Set a logging level. (For more on logging, see the notes at the end of this 
section and also in Chapter 6, “Setting project and application options.” The 
online Help system also explains the options available here.)

 6.  Under Format, accept the default HTML (to create a log file in HTML format for 
viewing in your browser) or select Text instead.

 7.  Under Steps, select the appropriate check boxes for the steps you want 
Document Publisher Server to complete when the project is run.

If you select Translate, the project will be automatically updated first. You can 
select all three check boxes, but you will lose the advantage of staging if you do 
so. To both stage and publish your project, you will want to schedule two 
tasks. In the first task, you would schedule the project for the sequence 
Translate–Stage (and thus select the Translate and Stage check boxes). For 
the second task, you would want to select only the Publish check box. 

If you have not staged your project and want only to publish, you would select 
the Translate and Publish check boxes. Conceivably, you might want to check 
only Translate.

 8.  Under Notification, complete the required information if you want Document 
Publisher Server to automatically generate an email notification each time the 
task runs. See “Sending an email notification for a task” on page 27 for more 
information. 

 9.  In the Post-processing field, enter the name of the executable file that will 
trigger any post-processing activity, immediately the project has run. (You need 
enter only the file name if the executable resides in the root of the installed 
directory for Document Publisher Server; otherwise, enter a full path.)

To schedule the task

 1.  Click the Schedule tab to open that tab dialog (see Figure 3-3).

 2.  Schedule a time for your project to run. 

Note that the scheduling times are set up in increments of a minute. If you 
select Every, the default setting of 1:00 represents one hour. With this option 
you should also specify the time period during which the task should be run. 

 3.  Click OK to return to Document Publisher Scheduler, where the new task is 
now listed in the task list. 

Repeat the above steps for the Specification tab dialog, and also these for the 
Schedule tab dialog, to schedule other projects for translation. When your task 
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list is complete, click the Close box on the title bar or choose Exit from the File 
menu.

If you prefer, you can quickly test a scheduled task to see that it will run 
smoothly without warnings and errors at the scheduled time. (See “Testing a 
scheduled task” on page 31.)

Figure 3-3  The Schedule tab dialog of the New Task dialog box, where you schedule the project.

Notes

The log file you create in the New Task dialog box (on the Specification tab 
dialog) is the “translation log” for the scheduled project. It is the same log file 
you would get if you ran a translation at your workstation, using FileNet 
Document Publisher. You must set the path and file name under Logging, 
because any logging information set in the Application Options dialog box in 
FileNet Document Publisher is user-specific for a given machine and is not 
saved to the project file. If a log file is not specified here, none will be created. 

In addition to the “translation log” specified in Document Publisher Scheduler, 
you can also have a “server log,” which is geared toward the server 
administrator and which you specify in Document Publisher Server. See 
Chapter 6, “Setting project and application options” on page 77.

When you use Document Publisher Scheduler to schedule a project for 
translation by Document Publisher Server, you cannot have that project open in 
Document Publisher Station during translation; otherwise, a sharing violation 
will occur. 

If your project file is on the file system, Document Publisher Server will 
automatically overwrite the current version of the file after it completes the 
translation.

Sending an email notification for a task
Each time a scheduled task runs on Document Publisher Server, an email can be 
automatically generated to confirm how successfully the task has been translated, 
staged, or published. You can also attach the translation log file to provide 
additional information on how the task ran.
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Email can be sent to anyone within the organization, but you will likely want the 
webmaster to be alerted on the outcome of translation, staging, and publishing.

To configure Document Publisher Server to send email notifications

 1.  From the Windows Control Panel, double-click the FileNet Document Publisher 
Server icon to open the FileNet Document Publisher Server dialog box. 

 2.  Click Notifications to open that tab dialog. Figure 3-4 shows the default 
settings, which you may have accepted during installation.

 3.  Under Mail Server Configuration, enter the address of your mail server in the 
Mail Server text box, such as mail.company.com.

 4.  Under SMPT Port, accept the default of 25 or, if necessary, enter a different 
port number.

 5.  In the Notification sender email address text box, enter the email address 
that represents the message sender. This may be a general mailbox, such as 
websupport@company.com. The email address entered here will be listed as 
the sender each time Document Publisher Server generates a notification email 
message.

Figure 3-4  The Notifications tab dialog of the FileNet Document Publisher Server dialog box, where 
you configure email notification for tasks.

 6.  In the System administrator email address text box, enter the email 
address of the system administrator if you want Document Publisher Server to 
send an email notification message to this address each time certain server 
errors occur. This may be a general mailbox, such as 
sysadmin@company.com, or any valid email address in the organization. This 
address is optional. If you provide it, the addressee will be notified by email of 
any server errors that occur when the task runs.

 7.  Click OK. 

Notes

An email notification on server errors contains information similar to that found 
in the server log.

Even if you do not want Document Publisher Server to generate email 
notification on server errors, you must enter information in the Mail Server 
Configuration and Notification Sender Email Address text boxes, since this 
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information determines the mail server and sender address that Document 
Publisher Server uses when sending all email notifications.

To send an email notification for a particular task, you must set options for that 
task in the New Task or Edit Task dialog box of Document Publisher Server, as 
described in the following section.

To set up an email notification for a task

 1.  In the Document Publisher Scheduler main window, click New on the Task 
menu to open the New Task dialog box, or select an existing task and click Edit 
on the Task menu to open the New Task or Edit Task dialog box (see Figure 3-
5).

Figure 3-5  The Specification tab dialog of the New Task dialog box, where you set up email 
notification for a task.

 2.  Under Notification, in the Email Address text box, enter the email address of 
the person who will be notified of the publication status, such as 
webmaster@company.com. You can enter only one address in this field. 

 3.  Under Notification, from the Notification Level drop-down list, select the level 
of notification you want to use for the task being scheduled.
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The information contained in the email is a summary of the translation log file. The 
following example displays the body of an email notification message for a task 
where the level was set to 3 – Always:

 4.  If you want to attach a log file, select Attach Log File to Notification. (You 
must also specify a log file and set the logging level under Logging.)

 5.  Click OK.

Notes

To send an email notification for a task, you must also set mail server, port, and 
sender information in the Document Publisher Server dialog box, as explained 
above, in “To configure FileNet Document Publisher Server to send email 
notifications.”

You can include the same project in more than one task (but only one project in 
each task). For example, you may want to set up email notification for a task 
that directs Document Publisher Server to translate and stage a project when it 
is run, and set notification for a different task that is set to publish the project 
at a later date. 

Level Description

0 - No notification No email is generated.

1 - Notify on errors Notification of errors that occur during translation, staging and publishing.

2 - Success with output Notification of errors that occur when output is generated during 
translation, staging and publishing, and
Notification when output is generated and translation, staging and 
publishing succeed.
When you select this level you will receive an email only when output is 
generated as a result of a task being run.

3 - Always Notification of all errors and successes that occur during translation, 
staging, and publishing.
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Testing a scheduled task
You may want to test a task before its scheduled time to run to be sure that there 
will be no problems when the task runs later, at the scheduled time. You can do this 
at any time before the scheduled time, including when you first add the project to 
the task list. (However, you cannot test a task on the task list that has expired.)

 1.  In the Document Publisher Scheduler window, select the task you want to test.

 2.  Click Run on the toolbar or choose Run  from the Task menu (or right-click 
the task and choose Run Task from the popup menu).

The Last Run column indicates progress as the task runs. It displays a green 
check mark to denote that the task has run successfully or a red cross to 
denote that the task has not run successfully. In either case, the time of the 
test also appears in the column. (See Figure 3-6.)

Figure 3-6  On this task list, the Last Run column reveals that tasks 1 and 2 failed to run successfully 
the last time and that task 3 has run successfully.

A task might fail to run for different reasons. For example, the project file may 
no longer exist or the machine on which Document Publisher Server is running 
does not have access to the repository where the project file resides.

You can easily obtain preliminary information on any task that has run (or failed 
to run).

 3.  Right-click the task in the task list and choose Info from the popup window. 
The Task Info dialog box opens (see Figure 3-7).

Figure 3-7  This project has run successfully without warnings or errors. 
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The Task Info dialog box provides a preliminary account of how the task has run. You 
should always check the log file in the event that a task fails to run successfully, or 
has run successfully but with warnings or errors.

Managing the task list
Projects can be added to the task list by users at workstations throughout the 
organization. Unless the webmaster is set up as a superuser, however, he will not be 
able to view all of the tasks on the list. 

To accomplish this, the webmaster must create a new DWORD value for the 
following Key in the Registry:
HKEY_CURRENT_USER\Software\Stellent\Content Publisher\Scheduler\6.0\Settings

The Value Name of the DWORD is “superuser” and its Value Data is 1. 

You can manage the task list in Document Publisher Scheduler very easily. As 
superuser, your privileges include the ability to edit tasks but not to change their 
ownership. A simple task list (with all the project files in the file system) is shown in 
Figure 3-8.

Figure 3-8  FileNet Document Publisher Scheduler, showing the task list with two projects each 
scheduled twice (once for staging, once for publishing).

The window displays key information about tasks on the task list, as follows:

ID — The project ID is assigned by Document Publisher Server. It is used simply to 
distinguish between the tasks that are run. 

Project — The path and name of the project file that has been added to the task 
list.

Status — The status of the task at any time. A task can be in one of five states:

Waiting - The task is awaiting its appointed time to run.

Pending - The task is ready to run, once other projects are completed. 

Running - The task is currently running. 

Expired - The task has run the required number of times and is not scheduled 
to run again.

Locked - The task schedule is currently being edited by another user.

Last Run — The date and time the task last ran. A green check mark denotes that 
the task has run successfully, while a red cross denotes that it has not.

Next Run — The date and time the task is scheduled to run next.

Owner — The login name of the user who scheduled the task.
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Pause Publishing command
You can use the Pause Publishing command to temporarily halt all translations 
scheduled to run on Document Publisher Server. Once you pause publishing, 
Document Publisher Server will continue to accept the scheduling of projects, but it 
will not translate any tasks until you choose the Continue command. You may want 
to use the Pause Publishing feature when your server is experiencing significant 
activity and other tasks take priority over your web publishing efforts.

Pause publishing works a little differently, depending on whether Document 
Publisher Server is installed as an OLE Automation server or as a Service.

To pause publishing when running Document Publisher Server as an OLE 
Automation server

 1.  Right-click the FileNet Document Publisher Server icon  on the 
Windows taskbar to display the FileNet Document Publisher Server popup 
menu.

 2.  Click Pause Publishing.

The popup menu closes. FileNet Document Publisher Server will pause all 
scheduled translations until you decide to continue.

To continue publishing after having paused

 1.  Right-click the FileNet Document Publisher Server icon  on the  
Windows taskbar to display the FileNet Document Publisher Server popup 
menu. Since you are in a pause state, the Pause Publishing command is now 
grayed out and the Continue command is now available.

 2.  Click Continue.

To pause publishing when running Document Publisher Server as a Service

If FileNet Document Publisher Server is set up to run as a Service, the FileNet 
Document Publisher Server icon is not available from the taskbar. In that event, you 
can activate the Pause Publishing command in the following way.

 1.  Click Settings on the Windows Start menu, and choose Control Panel from 
the submenu.

 2.  Double-click the FileNet Document Publisher icon, to open the FileNet 
Document Publisher Server Properties dialog box.

 3.  Click Control to open that tab dialog (see Figure 3-9).

 4.  Click Pause Publishing to pause the publishing process. 

 5.  Click OK.

When you are ready to continue publishing, return to this tab dialog and click 
Continue.
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Figure 3-9  The Control tab dialog in the FileNet Document Publisher Properties dialog box, which is 
available only when you run FileNet Document Publisher Server as a Service. 

To suspend an individual task

Finally, on occasion you may decide to temporarily suspend the translation of a 
particular project, one that is scheduled for translation at a regular time each day. 

 1.  Select the project in Document Publisher Scheduler, and choose Edit from the 
Task menu to open the Edit Task dialog box.

 2.  Click Schedule to open that tab dialog, and under Keep Running Until, click the 
Down control for the list box in order to change the Expires On date to 
yesterday’s date.

 3.  Click OK to return to the Document Publisher Scheduler main window. The 
Status column opposite the project will shortly read Expired.

Thus, without changing any of the settings for running this project, you have 
temporarily stopped the project from being translated. You can reschedule it at any 
time by re-entering the Edit Task dialog box and changing the Expires On date to an 
appropriate time in the future. 
34



FileNet Document Publisher Project setup in a FileNet repository
CHAPTER 4

Project setup in a FileNet repository

If you worked through the “Seven Easy Lessons” and the Tutorial, completing some 
or all of those exercises, you should now be familiar with how FileNet Document 
Publisher Station works in the file system. With FileNet Content Manager or FileNet 
Content Services installed, you are more likely to be taking source files from a 
FileNet repository and publishing to that repository. You can also use the FileNet 
repository to store the project files you create. Figure 4-1 depicts the more 
sophisticated environment you are working in.

Figure 4-1  You can add source files from FileNet Content Manager or FileNet Content Services to a 
project and publish back to the repository or directly to a web server. You can also save project files in the 
FileNet repository.

In this chapter we will review in detail how project setup differs when Document 
Publisher Station is used with a FileNet repository. The review will also address 
dynamic Directory Items and compound documents (for FileNet Content Services), 
and the ability to fine-tune the manner in which property values and security 
settings are applied to published output.

In short, you will learn about

Creating a project file in a FileNet repository 

Adding source documents from a FileNet repository

Adding a compound document

Adding a Directory Item from a FileNet repository

Adding a dynamic Directory Item

Adding a Directory Item from a stored search

Filtering and sorting Directory Items using metadata

Translating source documents 

Updating source documents

You will also learn about

Specifying a version of a source document
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Opening a project file from a FileNet repository 

Adding a version control feature

Chapter 5, “The Publishing Process,” covers in detail the dual-publishing capability 
of FileNet Document Publisher. It explains how to set up staging and publishing 
options, stage and publish a project to FileNet Content Manager or FileNet Content 
Services, and also how to output directly to a web server.

Note: If you are using FileNet Content Services, you must have IDM Web Services 
installed if you are to successfully browse published pages in Content Services. 

Creating a project file in a FileNet repository 
Creating a project file in a FileNet repository is similar to creating one in a file 
system. The essential difference is that by saving the project file to the repository, 
instead of to the file system, you take advantage of FileNet’s security, versioning, 
and other features.

The first set of steps is for FileNet Content Manager, and the second set of steps is 
for FileNet Content Services.

To create a project file in FileNet Content Manager

 1.  With a new project started in Document Publisher Station, click Save on the 
File menu. The Select a Repository dialog box opens. 

 2.  Choose FileNet Content Manager from the Repository drop-down list and 
click OK.

Note: If you are entering FileNet Content Manager for the first time (during 
your session in FileNet Document Publisher), the FileNet Content Manager 
Login dialog box opens. Complete the required information to gain access to 
the repository and click Sign In.

 3.  In the Save Project File dialog box, select a folder (within an object store) 
where you want to save the project. Then click Next.

 4.  Select a document class for the project file. Then click Next.

 5.  Specify the properties for the project (Document Title, Publish Status, 
Description, etc.). Then click Next.

 6.  Accept the security that will be assigned to the project file (or remove a user or 
group from the list). Then click Finish.

 7.  Click OK to return to the main window in Document Publisher Station.

You have now saved your project file to the repository. The project file name, 
including the .tcp extension, now displays in the title bar.

To create a project file in FileNet Content Services

 1.  With a new project started in Document Publisher Station, click Save on the 
File menu. The Select a Repository dialog box opens.

 2.  Select FileNet Content Services from the Repository drop-down list and click 
OK. The Save Project File dialog box opens.

 3.  Select the library you want to use and click Open. If you are entering FileNet 
Content Services for the first time, the FileNET Logon dialog box will open. 
Complete the required information to gain access to the repository, and then 
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click OK to return to the Save Project File dialog box, with the selected library 
now open.

 4.  Select the folder in which you want to save the project file.

 5.  In the Title text box in the Save Project File dialog box, enter the project file 
name. 

If you include the standard .tcp extension in the title, you will see it whenever 
you search for the project file in FileNet Content Services (it is not visible in 
FileNet Content Manager). Whether you include the extension or not, 
Document Publisher Station will automatically add it to the underlying file name 
(which means it will be visible, for example, in the title bar when the project is 
open in Document Publisher Station). 

 6.  From the Save As Doc Class drop-down list, select the class your organization 
is using for FileNet Document Publisher project files. (Your system 
administrator may want to set up a special class for such files.) Click Save.

 7.  In the Properties dialog box, complete the required information. 

Note: The contents of this dialog box are determined by how your classes are 
set up. For example, if your system administrator has created a Comment box, 
you could enter information that uniquely describes the project file (and thus 
facilitate future searches for the project file in the repository).

 8.  Click Security to open the Security tab dialog to set the necessary access level 
for the project file. (Refer to your FileNet Content Services documentation, if 
necessary.) 

 9.  Click OK to return to the main window in Document Publisher Station. You 
have now saved your project file to FileNet Content Services.

With the project file still open in Document Publisher Station, you can continue 
project setup. The latest version of the file will be checked into FileNet Content 
Services each time you use the Save command. In this way, you will be able to 
maintain version control of the project file. 

The history file
When Document Publisher Station creates a project file, it also creates a companion 
history file, which it uses to track the date and time-stamp of each source document 
in the project. As a result, when you run an incremental translation, Document 
Publisher Station translates only those source documents that have been updated 
since the last translation. 

Document Publisher Station creates a history file by appending the .tch extension to 
the name of the project file. Thus, for the project file “Project,” Document Publisher 
Station will create the history file “Project.tch.” 

In both FileNet Content Manager and FileNet Content Services, you will always see 
the project file without its .tcp extension. In FileNet Content Manager, the history 
file is a secondary file of the project document, and as such cannot be viewed in the 
repository. In FileNet Content Services, the history file is a separate document and 
can be seen in the repository with its .tch extension.

Do not delete the history file. In fact, you can safely ignore it. When you open a 
project file, Document Publisher Station automatically checks out both the project 
file and the history file from the FileNet repository and creates working copies of the 
files (just as it does with source documents, as explained in the next section). And 
when you close a project, Document Publisher Station automatically creates a new 
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version of the history file in the FileNet repository. (It updates the project file each 
time you save.)

Note: Always check the project file out of the FileNet repository. If you download a 
local copy of the file and publish, this will result in duplicate files because a new 
history file will be created.

Adding source documents from a FileNet 
repository

Once you have created and saved a new project file, you are ready to create your 
publication hierarchy and add source documents, Directory Items, and reference 
pages to the project. 

When you add documents that reside in FileNet Content Manager or FileNet 
Content Services, you do not check out those documents as you do in your normal 
use of the FileNet repository. Rather, Document Publisher Station identifies the 
current version of each document when it is added to the publication and obtains a 
working copy of that version for translation. As a result, someone else may check 
out one or more of those documents during your session in Document Publisher 
Station, between the time you start your project and are ready to publish. That is 
why you may want to use the Update Versions command before your final 
translation.

To add a source document to a publication

 1.  Select Document on the Add menu or click Add Document  on the 
standard toolbar. 

 2.  In the Select a Repository dialog box, select FileNet Content Manager or 
FileNet Content Services from the drop-down list and click OK.

Note: If this is the sole source of documents, you can choose Don’t show this 
dialog box again.

 3.  In the Add Document dialog box, browse to the desired document and click 
Select Current Version (for FileNet Content Manager) or Open (for FileNet 
Content Services).

 4.  In the Choose Template dialog box, select the template you want to use. (The 
preview changes to reflect the graphics Set associated with this template.)

 5.  Click OK to return to the main window. The document selected from the 
repository is now listed in the Contents pane.

Repeat the above steps to add more documents to the project.

Notes

Templates can be imported from, or exported to, Content Manager or Content 
Services. Also, linked templates can reside in the FileNet repository, as can 
associated files. (For more on templates, see “Managing templates,” Lesson 
10 of the Tutorial.)

If you change the location of a source document in Content Manager or FileNet 
Content Services, Document Publisher Station should be able to locate that 
document the next time it is needed for translation, assuming the document 
has been moved within the same object store or library. (If the document ID 
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changes, then Document Publisher Station will not be able to find the 
document.) 

If you are adding documents from Content Manager, only those with the 
Publish status can be previewed in the Choose Template dialog box. If you try 
to add a document with the Draft status, you will receive an error message.

Adding a compound document
If your repository is FileNet Content Services, you can add a compound document 
to your project in Document Publisher Station, just like any other source document. 
(This option is not available in FileNet Content Manager.) When Document Publisher 
Station translates the compound document, whatever relationships exist within the 
document are preserved. 

Include children of compound documents, the default setting that ensures this, 
can be found in the Options tab dialog of the Document Properties dialog box, as 
shown in Figure 4-2. (Right-click the document in the Contents pane and click 
Properties on the popup menu.) 

Note: This option is also available when you add a Directory Item, which you can 
see in the Properties dialog box for Directory Items (where the setting is also turned 
on by default). See “Adding a Directory Item from a FileNet repository” on page 41.

Figure 4-2  The Include Children of Compound Documents option is turned on by default so that 
FileNet Document Publisher Station automatically handles compound documents during translation. 
These options are only available when you are using FileNet Content Services.

A compound document is, in effect, two or more documents where one serves as 
the “parent” and the others serve as the “children.” 

Typically, there are two kinds of compound documents:

Linked OLE object — When a file containing a linked OLE object is checked 
into FileNet Content Services, the link recognizer automatically recognizes this 
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relationship, identifies the “children” (linked OLE objects), and classifies the file 
as a compound document.

Generic — The relationship between parent and child documents has been 
created manually. The child documents may be referenced in the parent 
document or they may be “random” documents associated with the parent. 
You formally create the compound document when you check it into FileNet 
Content Services.

In the case of the parent document with one or more linked OLE objects, Document 
Publisher Station creates the usual output page for the parent document, which 
contains a graphical representation for each OLE object. It translates the OLE 
objects separately and places each OLE object in its own output file. 

In the generic case, Document Publisher Station again translates both the parent 
and the child documents and preserves the relationship between them. However, 
since there may not be a graphical representation of a child document in the parent 
document, you need a way to make the child documents visible in your web 
publication. This can be handled in the TOC.

When you add a compound document to a project, Document Publisher Station in 
effect creates a hidden subpublication for the children of the compound document. 
The subpublication inherits the properties of the publication in which the compound 
document resides. So if you create a TOC for the publication that contains the 
compound document, Document Publisher Station will create a TOC in the 
subpublication for the children. 

In addition, you can view the TOC entries for the compound document separately, if 
you want. That is, you can make the TOC for the compound document appear in the 
same frame as the body pages, immediately following the compound document in 
the viewing sequence. To do this, you need to select the following check box in the 
Publication Properties dialog box for the publication in which the compound 
document resides:

You can open this page by clicking the Next button in the output page for the parent 
document. Such a page will be especially desirable where your compound 
document contains a “random” child that is simply associated with the parent, not 
referenced in it in any way.

Notes

In the generic case, the parent document could be designed solely to create a 
relationship for the child documents. That is, it could be an empty source 
document that generates no output. It would be used simply as a placeholder 
in Document Publisher Station.

Child documents are not visible in the Contents pane. You see them only when 
you translate and view your web publication.

Document Publisher Station creates a hidden subpublication for a dynamic 
Directory Item in the same way it does for a compound document. See “Adding 
a dynamic Directory Item” on page 44.
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Adding a Directory Item from a FileNet repository
A Directory Item is simply a container for adding multiple source documents to a 
publication. In the file system, the container can be a directory or folder on a local 
or network drive. In FileNet Content Manager, the container can be a folder in an 
object store; in FileNet Content Services, it can be a folder in a library.

When you translate, all source documents at the top level of the container are 
translated. This is especially useful when you schedule projects for automatic 
translation by Document Publisher Server. You can add new source documents to 
the folder at any time and be assured that they will be included in the next 
scheduled translation. (See “Updating dynamic Directory Items and compound 
documents” on page 50.)

The feature is potentially more powerful when you add a dynamic Directory Item to 
your project. (See “Adding a dynamic Directory Item” on page 44.) But first, let us 
address the straightforward case. 

To add a Directory Item 

 1.  Click Directory Item on the Add menu to open the New Directory Item 
Properties dialog box (see Figure 4-3). If the Select a Repository dialog box 
opens, select FileNet Content Manager or FileNet Content Services from 
the Repository drop-down list and click OK.

Figure 4-3  The New Directory Item Properties dialog box, where you create a Directory Item. When 
you choose the FileNet Content Manager or FileNet Content Services repository option, all files in the 
selected object store or library (as specified in the Directory text box) will be added to your publication.

 2.  Click the Browse button opposite the Directory text box to open the Browse 
for Folder dialog box.

 3.  Select the appropriate folder you want to use for the Directory Item.
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In the New Directory Item Properties dialog box, the Directory text box lists the 
path to the folder in the FileNet repository.

 4.  Under Title, enter the title you want to use for the Directory Item. (You do not 
have to enter one. If you do, it will help to differentiate between different 
Directory Items on the Contents pane. It could also be used to populate the 
titles of your output pages.) 

 5.  In the Map File Property text box, type any string of text you want added to 
the XML Map file. (With proper customization, such strings can be used to 
control access to published content on a web site.)

 6.  In the Prefix to be added to all output file names text box, enter the prefix 
to apply to each output file in this Directory Item. (This is not required.)

 7.  Under Output Directories, enter names for the output directories you want to 
use for these source documents.

You can leave these text boxes blank, if you prefer. If you enter paths, these 
must be for the file system, because when you translate source documents 
(with the Translate or Translate All command), you can send the output files 
only to the file system. This is explained in the next section. 

Generally, you will not want to enter a full path. By default, Document 
Publisher Station uses the full paths specified for the root publication and 
mirrors the publication hierarchy in the structure of the output directories it 
creates. So in the fields for output directories for a Directory Item, you can 
simply enter just the names for the output directories you want to use. This will 
be especially helpful where a publication contains more than one Directory 
Item, and you want to segregate the output files of the different Directory 
Items.

 8.  Under Template, click the Choose Template button to open the Choose 
Template dialog box and select the template you want to associate with the 
source documents in the Directory Item. 

With a Directory Item, all source documents must be associated with the same 
template.

 9.  Click OK to return to the New Directory Item Properties dialog box.

Note: On the Sort tab dialog of the Directory Item Properties dialog box, you can 
influence the order in which source files are translated and linked. On the Options 
tab dialog, you can set conversion options and an extension for output files that will 
apply only to the Directory Item.

See Lesson 15 in the Tutorial for more information.

To specify file formats

Now that you have set up the Directory Item, you can specify what file formats you 
want translated. Let us first explore how this is done. (A later section will examine 
how to filter and sort Directory Items by using metadata.)

 1.  Click the  button to open the Details dialog box (see Figure 4-4).
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Figure 4-4  In the Details dialog box you can instruct FileNet Document Publisher to translate any 
combination of file formats. (For an explanation on how to use the Filter and Sort Order options, see 
“Filtering and sorting Directory Items using metadata” on page 47.)

 2.  In the text box, enter the appropriate string for the file formats you want 
Document Publisher Station to translate. Separate multiple entries with 
semicolons. You can use wildcards to capture files with certain naming 
conventions. 

Example: *sales.xls;Q1*.doc;*.ppt

Document Publisher Station will translate (a) all Excel file names that end with 
“sales,” (b) all Word file names that begin with “Q1,” and (c) all files created in 
Microsoft PowerPoint.

 3.  Click OK to return to the New Directory Item Properties dialog box.

One last task is to visit the Option tab dialog.

To specify options

 1.  Click the Options tab to open that tab dialog. (See Figure 4-5.)

Settings in the Options tab dialog allow you to (a) change the file name 
extension of the output pages, if desired, and (b) set dynamic options.

 2.  Under Dynamic, select Include subdirectories if you want to create a dynamic 
Directory Item in your project (see “Adding a dynamic Directory Item” on 
page 44).

 3.  If you're using FileNet Content Services as the repository, you can select 
Include children of compound documents. This will ensure that FileNet 
Document Publisher recognizes and preserves the relationships in any 
compound documents included in the Directory Item (see “Adding a compound 
document” on page 39).

Note: This option is not available for FileNet Content Manager.

 4.  Click OK to return to the main window.
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Remember: You can always revisit the Properties dialog box later (as you can for 
any publication or document) to edit the settings.

Figure 4-5  The Options tab dialog for a Directory Item. Note the two options under Dynamic.

You have now completed the setup of a Directory Item for a publication. You can 
add other Directory Items in the same way. If you provide a title in each case, you 
will be able to distinguish between them in the Contents pane. 

Now let us examine the implications of the Include subdirectories option.

Adding a dynamic Directory Item
When you add a Directory Item from the file system, you have the potentially 
powerful option of making the Directory Item dynamic. You do this by selecting the 
Include subdirectories option in the Options tab dialog of the New Directory Item 
Properties dialog box. 

If you accept the default setting (by leaving the check box cleared), only individual 
source documents at the top level of the specified folder will be added to the 
project. That is, you will create a Directory Item in the usual way. However, if you 
select Include subdirectories, Document Publisher Station not only imports the 
specified folder, but also the hierarchy of folders that the specified folder contains. 
Moreover, it automatically processes source documents in all the folders.

Notes

Only the parent Directory Item is visible in the Contents pane. 

Document Publisher Station in effect creates a hidden subpublication for the 
subfolders of the parent Directory Item (just as it does for a compound 
document). The subpublication inherits the properties of the publication in 
which the dynamic Directory Item resides. 

If you create a TOC for the parent Directory Item, you are, in effect, creating a 
TOC for each subfolder—and the contents of the subfolders are promoted so 
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that the TOC for the parent Directory Item summarizes the complete hierarchy 
of the dynamic Directory Item. 

Promotion and linking specified in the template for the TOC of the parent 
Directory Item apply to all subfolders. Likewise, any reference pages you assign 
to the parent Directory Item (as well as any files associated with the parent) are 
automatically inherited by the subfolders, too. 

Document Publisher Station includes in translation any new subfolders added 
to the hierarchy in the future. This can be handled automatically (see “Updating 
source documents” on page 49”).

Stored document searches within the selected stored search (see next section) 
are picked up as subpublications when dynamic Directory Items are enabled. If 
the stored search subpublication contains additional stored searches, however, 
they will not be picked up by Document Publisher Station. (In other words, 
stored searches can only go one level below the Directory Item stored search in 
order to be included in your publication.)

The Folder Import wizard
It is worthwhile comparing the dynamic Directory Item with the Folder Import 
wizard. Like the dynamic Directory Item, the Folder Import wizard can import a 
portion of an object store hierarchy in FileNet Content Manager or a library 
hierarchy in FileNet Content Services (or a portion of the file system). However, 
there are important differences:

Whereas the dynamic Directory Item is dynamic, the Folder Import wizard is static. 
That is, while Document Publisher Station recognizes any new folders added later to 
the hierarchy of a dynamic Directory Item, it ignores any new folders added later to 
the hierarchy imported by means of the Folder Import wizard. 

Only the parent Directory Item of a dynamic Directory displays in the Contents 
pane, but the individual Directory Items imported by means of the Folder Import 
wizard can be seen in the Contents pane, depending on which subpublication (folder 
in the hierarchy) is selected in the Publication Hierarchy pane. 

Since you can see only the parent Directory Item of a dynamic Directory Item, the 
same template and settings must be applied to all folders and documents in a 
dynamic Directory Item. Since you can see the individual Directory Items that result 
from importing a folder hierarchy with the Folder Import wizard, you can apply 
different templates and settings to each Directory Item in the hierarchy.

(The dynamic Directory Item option is turned off by default. However, you can turn 
on this option at any time.)

Adding a Directory Item from a stored search
If your repository is a FileNet repository, any search you perform in the repository 
can be saved as a stored search, making it easier to perform the same search again 
in the future. Stored searches (see Note 1) can be added to Document Publisher 
Station as a Directory Item, much like a folder can. Any new documents added to 
the FileNet repository with the same stored search criteria will be included in the 
Directory Item.

Note: For more information on creating stored searches, see the FileNet Workplace 
Help or the FileNet IDM Desktop User's Help.
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To add a stored search from FileNet Content Manager 

 1.  Click Directory Item on the Add menu to open the New Directory Item 
Properties dialog box.

 2.  Select FileNet Content Manager from the Repository drop-down list.

 3.  Opposite Directory, click Browse to open the Browse for Folder dialog box.

 4.  Browse to the stored search file  in FileNet Content Manager and select it.

Note: The stored search must be created ahead of time using FileNet 
Workplace before you can select it in this dialog box.

 5.  Choose a template for your directory item and click OK to return to the main 
window.

To add stored search from FileNet Content Services

 1.  Click Directory Item on the Add menu to open the New Directory Item 
Properties dialog box.

 2.  Select FileNet Content Services from the Repository drop-down list.

 3.  Opposite Directory, click Browse to open the Browse for Folder dialog box.

 4.  Click Stored Search to open that dialog box.

 5.  Browse to your stored search file  in FileNet Content Services and then click 
Open.

Note: The stored search must be created ahead of time using FileNet IDM 
Desktop before you can select it in this dialog box.

 6.  Choose a template for your directory item and then click OK to return to the 
main window.

Notes

A stored search is a file that contains saved search criteria in the FileNet 
repository. For more information on creating stored searches, see the 
appropriate FileNet repository documentation.

Document Publisher Station includes in translation any new documents that are 
added to the FileNet repository with the criteria specified in the stored search. 
To update the new source documents, see “Updating source documents” on 
page 49.

Stored document searches within the selected stored search are picked up as 
subpublications when dynamic Directory Items are enabled (see “Adding a 
dynamic Directory Item” on page 44). If the stored search subpublication 
contains additional stored searches, however, they will not be picked up by 
Document Publisher Station. (In other words, stored searches can only go one 
level below the Directory Item stored search in order to be included in your 
publication.)
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Filtering and sorting Directory Items using 
metadata

When you add a Directory Item to a publication, you can determine the documents 
to include based on simple metadata. For FileNet Content Manager, this is the 
metadata found in the My Search>For Documents page of the FileNet Workplace: 
Filter by Class, Document Title, and Creator. For FileNet Content Services, this is the 
metadata found on the Simple Find tab dialog of the FileNet IDM Find feature. Such 
metadata includes Title, Document Class, ID, and Added by User.

Furthermore, you can sort the order of those documents, ascending or descending, 
based on the same metadata. The order is important because it will determine how 
the output files are linked and the order in which the web pages you create can be 
browsed onscreen.

To filter or sort Directory Items based on metadata

 1.  Right-click the Directory Item in the Contents pane and choose Properties 
from the popup menu.

 2.  In the Document Properties dialog box, click the  button to open the 
Details dialog box. (See Figure 4-4.)

 3.  If you want to include files matching certain criteria, replace *.* in the File 
Specification text box.  Separate multiple entries with semicolons.

Example: *.doc;*.123;*.wpd  

 4.  Under Filter, enter the metadata for Title, Document Class, ID, and Added by 
User.

 5.  Under Sort Order, choose a metadata field on which to sort the Directory Item, 
and then select Ascending or Descending.

 6.  Click OK to close the Details dialog box, and click OK again to return to the 
main window.

Notes

In order to sort Directory Items based on metadata, you must first disable 
sorting by file attribute. You can do this by selecting Do not sort this 
directory item on the Sort tab of the Directory Item properties dialog box. 

When adding a Directory Item from the file system, the File Specification field is 
provided in the New Directory Item Properties dialog box, not the Details 
dialog box. 

Translating source documents
Once you have set up your project in Document Publisher Station, you will initially 
follow the two-step sequence of Translate–View as you fine-tune your templates and 
other settings to create your web publication. In fact, you will probably use this 
sequence repeatedly until you are satisfied with your publication structure, the 
formatting of source documents, and the content and formatting of reference pages. 

You learned about translation in the Seven Easy Lessons and the Tutorial. Since you 
always translate to the file system, the translation issues with Document Publisher 
Station are essentially unchanged. Here are reminders of some setup issues you 
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may need to review before you update your project, as discussed in the next 
section:

 1.  When you create a new project, Document Publisher Station uses default 
output directories, which means that you can translate as soon as you add one 
or more source documents to your publication. However, you may want to use 
a different location for your translated output. 

 2.  You specify output directories in the Publication Properties dialog box. Right-
click the root publication and choose Properties from the popup menu to open 
the dialog box. The default directory shown in Figure 4-6 applies when running 
Document Publisher Station on Windows 2000 or Windows XP. 

 3.  When Document Publisher Station translates source documents and generates 
any reference pages you have added to the project, it places all output files in 
the specified output directory, using a hierarchy that matches the hierarchy in 
the Publication Hierarchy pane (unless you specify otherwise).

 4.  You can create a special output directory for graphics from the Gallery by 
selecting the Use gallery graphics directory check box and entering a full 
path for the directory. Large projects, in particular, will benefit from this 
because you will avoid the duplication of graphics used for navigation. This 
option is available only in the Publication Properties dialog box for the root 
publication.

 5.  The Translate command on the large toolbar is for an incremental translation. 
The first time you translate a project, Document Publisher Station translates all 
the source documents in the project. Thereafter, it recognizes those that have 
been updated and translates only those. (The next session addresses in detail 
the process of formally updating your project.)

 6.  If a FileNet Document Publisher project that is scheduled to run on Document 
Publisher Server has references to object stores in FileNet Content Manager or 
libraries in FileNet Content Services, you will need a user name and password 
to access them. (See “Registering a user name and password” in Chapter 3 of 
the Installation Guide.)

With your translated output in the file system, you can experiment with template 
settings and the like until you are ready to publish to your FileNet repository (or 
directly to a web server). When you finally publish, Document Publisher Station 
makes copies of the output files in the staging area (the output directories), fixes up 
the URLs to point to IDs, and places the files in location in your repository specified 
in the Publish Options dialog box.

A key step before finally publishing is updating the source documents and Directory 
Items in your project. 
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Figure 4-6  The Publication Properties dialog box, where you specify output directories in your file 
system for translations.

Updating source documents 
As noted, Translate–View is the two-step sequence you follow to create a web 
publication in Document Publisher Station. When you are satisfied with the 
publication and are ready to publish, you use the three-step sequence Update 
Versions–Translate–Publish. 

Update Versions reviews the status of your selected source documents in Content 
Manager or Content Services and on the file system, and identifies any that have 
been checked out and revised since you first added them to your publication. If 
newer versions exist, Document Publisher Station updates the recorded version 
number of each document. Unless you have specified that a particular version be 
used, it creates a new working copy the next time you translate.

Note: Source documents in a FileNet repository must have their Publish status set 
to ”Publish” in order to be translated.

After each update, you will want to use the Translate command again, to generate 
updated translated output on the file system. (You may also want to View your 
publication one last time before you publish.)

With the Publish command, Document Publisher Station copies all files in the file 
system to the location in Content Manager or Content Services specified in the 
Publish Options dialog box. It fixes up URLs to make them relative so that the files 
can be accessed later on a Web server.
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Using the Update Versions command

To update a project, click Update Versions  on the toolbar or choose Update 
Versions from the Run menu. This will update all source documents in the project. 
To update only certain source documents, select a subpublication in the Publication 
Hierarchy pane and highlight one or more Directory Items or source documents in 
the Contents pane (you can use your Ctrl key and mouse to select multiple 
documents). Then right-click and choose Update Versions from the popup menu. 

Notes

When all the source documents are from the file system and any Directory 
Items are not dynamic, you do not need to use the Update Versions command. 
Simply translate. Otherwise, always use the Update Versions command.

You may not always want to use the latest version of a document. If you specify 
a version, the document will not be subject to updating by the Update Versions 
command and the specified version of the document will be used each time 
you translate. See “Specifying a version of a source document” on page 51.

Updating dynamic Directory Items and compound 
documents

When your project contains dynamic Directory Items or compound documents, 
whether or not their source is the file system or FileNet Content Manager or FileNet 
Content Services, you must use the Update Versions command. This is because 
Document Publisher Station not only checks for the newest version of each source 
document, but also for any structural change in the dynamic Directory Item or 
compound document.

If you have added a new folder to a dynamic Directory Item since the last time you 
translated, Document Publisher Station will recognize this and include the new 
folder in the next translation. Likewise, it will recognize any change in a compound 
document (for example, where a child document has been added or removed).

When a project contains a dynamic Directory Item or compound document, 
Document Publisher Station displays the following reminder when you translate.

Figure 4-7  If at any time you select Don’t Show This Dialog Box Again, you can always show the 
dialog box again by opening the Applications Options dialog box (from the View menu) and selecting the 
appropriate check box on the Dialogs tab. 

By selecting Yes, always update before translating and also Don’t show this 
dialog box again, you in effect automate the process of updating dynamic 
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Directory Items and compound documents when working in FileNet Document 
Publisher Station.

Using FileNet Document Publisher Server
When you schedule projects to run on Document Publisher Server, all source 
documents, Directory Items, and compound documents are automatically updated, 
because Document Publisher Server executes four commands—Update Versions, 
Translate, Stage and Publish—automatically. (See Chapter 3 for more information 
on how Document Publisher Server automates the staging and publishing of a 
project.)

Specifying a version of a source document
When you translate a project, FileNet Document Publisher uses the newest 
published version of each source document by default. You can specify another 
version, instead. In fact, Document Publisher Station offers three options for 
specifying which version of a source document to use:

the newest published version (the default)

a version specified in FileNet Content Manager or FileNet Content Services 
(requires a custom feature)

a version specified in Document Publisher Station 

To specify the newest published version in FileNet Document Publisher

 1.  With your project open in Document Publisher Station, right-click a source 
document in the Contents pane and choose Properties from the popup menu.

 2.  In the Document Properties dialog box, click the  button to open the 
Details dialog box (see Figure 4-8).

 3.  Be sure that the Allow refresh to newest published version option (the 
default setting) is selected.

 4.  Click OK to return to the Document Properties dialog box, and OK again to 
return to the main window.

Figure 4-8  The Details dialog box in FileNet Document Publisher Station for a source document, 
showing the default setting, which will respect any custom feature you set in FileNet Content Manager or 
Content Services for the source document selected. However, the Use this specific version option will 
override any such custom feature. 
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With the default setting of Allow refresh to newest published version—and 
absent any custom properties in Content Manager or Content Services—each time 
you use Update Versions, Document Publisher Station identifies the latest version of 
a source document in the FileNet repository and retrieves a working copy of that 
version for translation. If you create custom properties for source documents in the 
FileNet repository and retain the default settings, the settings for the custom 
properties will prevail (see next).

To specify a version in the FileNet repository

You can increase your publishing options by adding the Publish Status custom 
property in Content Manager or Content Services. This option lets you toggle 
between the Draft and Publish status as you create and maintain source documents 
in a publication. See “Adding a version control feature” on page 55.

With this option, you must assign either the Draft or Publish status to a document 
each time you check it into FileNet Content Manager or Content Services. Whenever 
you click Update Versions, Document Publisher Station automatically checks for all 
versions of the document with the Publish status assigned to them and uses the 
latest one for translation.

Note: If you add an incomplete document to a publication for the first time, and 
initially use the Draft status to check the document into the FileNet repository, the 
document name will serve as a placeholder—the document will not be translated. 
When you check the final version into FileNet Content Manager or FileNet Content 
Services and assign the Publish status for the first time, the document will then 
become part of the updating process and be included in the next translation. 

For FileNet Content Manager

 1.  Sign in to FileNet Workplace and browse to the source document.

 2.  Click  beside the document to open the Properties page.

 3.  Beside FWP Publish Status, choose Publish.

 4.  Click Apply to apply the settings and then choose Exit.

 5.  Sign out of FileNet Workplace and proceed to “To specify the newest published 
version in FileNet Document Publisher” on page 51.

For FileNet Content Services

 1.  In FileNet IDM Desktop, right-click the source document and choose 
Properties from the popup menu.

 2.  In the Document Properties dialog box, click the Properties tab.

 3.  Beside Publish Status, click Publish.

 4.  Click OK to close the Document Properties dialog box and proceed to “To 
specify the newest published version in FileNet Document Publisher” on 
page 51.

As long as you preserve the Publish status as you check the document into the 
FileNet repository, the Update Versions command will identify the latest published 
version of the document and use a working copy of that version for translation.

Draft status
You can use the Draft status to add a new document to a publication as a 
placeholder initially, as explained above. Once a document is part of a publication 
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and has been published at least once, you may want to continue to use the latest 
published version on your web site while you revise the document. The Draft status 
facilitates this, too.

To assign the Draft status to a document

 1.  Follow the steps outlined in “To specify the newest published version in FileNet 
Document Publisher” on page 51.

 2.  In the FileNet repository, follow the same steps to assign the Publish status 
(see “For FileNet Content Manager” on page 52 and “For FileNet Content 
Services” on page 52) and instead choose Draft.

Document Publisher Station will continue to translate and publish the latest 
published version of the document. But as long as you apply the Draft status to the 
document each time you check it into the FileNet repository, you can continue to 
revise the source document until you are ready to release the revised version for 
translation. To do that, simply change the document’s status to Publish.

To specify a version in Document Publisher Station

A third option is to specify a version in Document Publisher Station.

 1.  In the Contents pane, select the source document you do not want to be 
updated by the Update Versions command.

 2.  Right-click the document and choose Properties from the popup menu.

 3.  In the Document Properties dialog box, click the  button to open the 
Details dialog box (see Figure 4-9). By default, the Allow refresh to newest 
published version radio button is selected. The version number of the 
document currently selected for translation displays opposite Major Version or 
Minor Version. It also displays text boxes under Version Specification.

Figure 4-9  The Details dialog box, where you can specify a particular version of a source document in 
FileNet Content Manager to be used for your web publication. (For Content Services, the interface is 
slightly different.)

 4.  Under Version Specification, select Use this specific version. 

If you are entering this dialog box for the first time for this document, the 
version number displayed in the text box will be the latest one available when 
you added the document to your publication.

 5.  In the text box, enter the version you want to use for all future translations of 
this document.
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 6.  Click OK to return to the Document Properties dialog box, and OK again to 
return to the main window.

Even where you use the Update Versions command to update the other source 
documents in your project, Document Publisher Station ignores any later versions of 
this document and also any custom feature that you have applied to the document 
in Content Manager or Content Services. It translates only the version specified.

Update status
The Contents pane can guide you generally as to whether source documents are out 
of date and your project needs to be updated and re-translated. 

Where source documents from the file system have been added individually to a 
project, the Status column always tells you whether the latest version has been 
translated or not. A red cross in the Status column signifies that the source 
document has been updated since the last translation. An incremental translation 
would automatically recognize and translate this document.

However, with a Directory Item (dynamic or not), you will not know. This is because 
a Directory Item can contain many source documents, some of which may be up to 
date and others not. The same applies to source documents and Directory Items 
from FileNet Content Manager or FileNet Content Services. That is why the Update 
Versions command is so important.

Individual source documents from the repository that are subject to updating by the 
Update Versions command have an asterisk after their name. So if you specify a 
particular version of a source document, you will be able to tell from the Contents 
pane because that document will not have an asterisk after it. 

Figure 4-10  The first two documents are from FileNet Content Manager or FileNet Content Services. 
The first (with an asterisk) is subject to updating with the Update Versions command. The second (without 
an asterisk) is not, because a version has been specified for translation.

Opening a project file from a FileNet repository
Once you check a new project file into FileNet Content Manager or FileNet Content 
Services, you can use it right away in Document Publisher Station. And you can 
open the file at any time from the FileNet repository for future sessions in Document 
Publisher Station.

To open a project file from FileNet Content Manager

 1.  Click Open  on the toolbar.

 2.  In the Select a Repository dialog box, choose FileNet Content Manager and 
click OK.

 3.  In the Open a Project dialog box, browse to the folder (within an object store) 
where the project file resides.
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 4.  Click Select Current Version beside the project file you want to open. Or, 
click Select from Versions and then select the desired project file from the 
list.

 5.  This returns you to FileNet Document Publisher Station, where you can start 
working on your project.

To open a project file from FileNet Content Services 

 1.  Click Open  on the toolbar.

 2.  In the Select a Repository dialog box, choose FileNet Content Services and 
click OK.

 3.  In the Open a Project dialog box, browse to the folder (within a library) where 
the project file resides.

Or, enter a search criteria (Title, Doc Class, Doc ID, etc.) and click Find Now to 
locate the project file.

 4.  Select the project and click Open.

 5.  This returns you to FileNet Document Publisher Station, where you can start 
working on your project.

Note: If the project is currently checked out, you can open the project in the FileNet 
repository, right-click, choose Cancel Checkout, and then click Yes to keep the 
local copy of the project.

When you create a project file, Document Publisher Station automatically creates a 
companion history file, which it uses to track the date and time-stamp of each 
source document. (See “The history file” on page 37.)

When using FileNet Content Services, be sure to check out the project file, which is 
listed without its .tcp extension (unless you formally added the extension when you 
first saved the file). If you mistakenly try to check out the history file, which has a 
.tch extension, you will receive an error message. (In FileNet Content Manager you 
will not see the history file.)

Adding a version control feature 
You can fine-tune your publishing options by adding the Publish Status custom 
feature to the FileNet repository. With this feature you can assign either a “Publish” 
or “Draft” status as you check each document into the FileNet repository using 
FileNet Document Publisher. (See “Assigning the Draft status to a source document” 
and “Assigning the Publish status to a source document” in the Help system.) As a 
result, you gain finer version control over the source documents you translate and 
publish. 

To add a version control feature in FileNet Content Manager 

Use the Add Properties to Class Wizard in FileNet Workplace to create a new 
custom property for a class.

Use the Create Property Template Wizard to create a template.

Use the Properties Template Choice List Wizard to define a single-value choice 
list.
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Adding a version control feature in FileNet Content Services 

Create and define a new custom property in IDMDS Explorer, using “Publish 
Status” as the property name and selecting “Version” for the Parent Object. Do 
not make it a Multivalue setting.

Add the property to the document class using the DocClass and CVL 
Administration dialog box.

Define the CVL for the new custom property again, using the DocClass and CVL 
Administration dialog box. (The CVL should have the same name as the 
property and should have the data values Publish and Draft.)

Define the document class by assigning the CVL to the new custom property 
and setting the property default as Draft.

Registry entries for existing properties/values 

If you already have a suitable property/value in an existing Document Class, you can 
adapt the property and value for use in this custom feature by modifying the 
following Registry key:  

Add two string values: “PublishName” and “PublishValue.” Assign your property 
name to the PublishName and your trigger value to the PublishValue. (It may be 
necessary to create the “FileNET” Registry key if one does not exist.) 

Note: If these keys are not detected, FileNet Document Publisher uses a default 
“PublishName=FDPPublishStatus” and “PublishValue=1” (for FileNet Content 
Manager) and “PublishName=PublishStatus” and “PublishValue=Publish” (for 
FileNet Content Services).

Repository Registry key

FileNet Content Manager HKEY_LOCAL_MACHINE\Software\Stellent\Content 
Publisher\Repository\6.0\FileNet Content Manager

FileNet Content Services HKEY_LOCAL_MACHINE\Software\Stellent\Content 
Publisher\Repository\6.0\FileNET
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CHAPTER 5

The publishing process

The growing sophistication of web publishing demands an increasing commitment 
by enterprises. The goal is to not simply create a web site, but to also maintain that 
site through constant changes. The difficulty is to not simply handle the sheer 
quantity of information that an enterprise may seek to publish—often intimidating in 
itself—but to also meet the ever-pressing challenge of updating that information 
without disrupting the web site.

Key concepts and roles
Successful web publishing requires the efforts of a multi-skilled team working within 
a clearly defined process. For the purposes of this chapter, we will assume a project 
team consisting of:

content author, who is responsible for content creation (possibly with one or 
more reviewers responsible for approving that content) 

project author, who is responsible for creating the publication hierarchy, fine-
tuning templates, creating navigation links, etc., and for sending the web 
publication to the staging location for review

webmaster, who is responsible for reviewing the web publication on the 
staging location and authorizing publishing—that is, placing the web 
publication on the web site (the publishing location)

These three roles represent distinct activities in the publishing process: content 
creation, project creation, and staging and publishing. 

Note: In small organizations, a single person might assume all three roles. In large 
enterprises, there may be multiple content authors (and multiple reviewers). There 
may even be multiple project authors, with a lead author in charge of the master 
project and the others responsible for “linked publications.” 

Stepping through the process
The publishing process consists of: 

Creating content in FileNet Content Manager or FileNet Content Services 

Creating a project in Document Publisher Station by adding the approved 
source documents to the project, creating the publication structure, setting 
navigation, and so forth

Updating and translating the web publication you create (on a local or network 
drive) to test the look and feel of the publication

Setting staging options and then actually staging (copying the translated output 
to the staging location) 

Reviewing the completed web publication in the staging location 

Setting publishing options and then actually publishing (copying all translated 
output to the publishing location—that is, to the web site)
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The above can be done manually within Document Publisher Station. You can also 
use Document Publisher Server to automate the process, including both the staging 
and publishing of output, as we will see later. 

Creating a project
Chapter 4 outlined the basics of handling project files in Document Publisher Server. 
There are additional tasks you need to consider to take advantage of the publishing 
process. You may want to:

Add a linked publication to a project 

Set staging options

Set publishing options

Use Document Publisher Server to automate both staging and publishing

In this section, we will look at linked publications. Later sections will address staging 
and publishing options, as well as automating the staging and publishing of your 
project. 

Adding a linked publication to a project
Just as you can add a Directory Item as a subpublication to a project, so, too, you 
can add another project. When you add one project as a subpublication to a second 
project, the first project becomes a linked publication (or subproject) and the 
second project becomes the master project. Each time you run a translation of the 
master project, the contents of the linked publication are translated, too.

However, to change a linked publication, you must open the linked publication by 
itself in Document Publisher Station. And the next time you open the master 
project, you must be sure to use Update Versions before translating so that the 
changes made to the linked publication are reflected in the translation of the master 
project. 

Linked publications can be especially useful in large projects where a heavy 
workload and complex publication hierarchy demand multiple project authors (and 
multiple content authors). The lead project author can be responsible for the master 
project, with other project authors handling portions (linked publications) of the 
master project.

To add a linked publication

 1.  With your project open in Document Publisher Station, select the 
subpublication in the publication hierarchy that will contain the linked 
publication.

 2.  Click Publication on the Add menu to open the Add Publication dialog box. 

 3.  Click the Add Linked... button, and in the Open dialog box locate the project 
file for the project you want to add as a linked publication.

 4.  Select the project file and click OK to return to the Add Publication dialog box. 

The publication name of the project is used for the name and title of the new 
subpublication you have just created for the linked publication. It is also used 
for the subfolder of output directories. You can change this, if you want.

 5.  Click OK. 
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You have now added a linked publication, which appears as a subpublication of the 
publication originally selected. Both the linked publication (in the Publication 
Hierarchy pane) and its contents (as displayed in the Contents pane) are grayed out 
to signify that you cannot edit a linked publication while it is part of a master 
project. The linked publication must be maintained separately, and opened by itself 
in Document Publisher Station to be updated.

Note: You can convert a linked publication into a regular publication at any time. 
Right-click the linked publication in the Publication Hierarchy pane and choose 
Make embedded from the popup menu. Click Yes in the dialog box that appears. 
The publication is now a permanent part of the master project and its contents can 
be edited like those of any other subpublication. (The project file for the linked 
publication still exists in its original location and can be used for other purposes, if 
you want.)

Updating source documents 
Once you have completed project setup and have your publication hierarchy in 
place, you can begin testing template settings, navigation, and so forth. During this 
phase of the publishing process you are translating the project to a local or network 
drive and are therefore involved with the three-step sequence of Update-Translate-
View. 

Once you are satisfied with the structure and formatting of your publication, you are 
ready to stage your output, that is, have Document Publisher Station copy your 
translated output from the file system to a staging location so that you can formally 
review your web pages before publishing the content to a web site. Later still, you 
will finally publish to the web site. So the complete sequence is Update-Translate-
View-Stage-Publish. 

You will want to use the Update Versions command as you create your project. You 
will not necessarily want to use the command before each translation, but you will 
certainly want to use it at critical times during project creation to be sure that what 
you are reviewing contains the latest content. This obviously becomes more 
important during staging, and more important still before you finally publish.

The Update Versions command is important because when you add source 
documents to a publication, you do not, in fact, check out those documents from 
FileNet Content Manager or FileNet Content Services. Rather, Document Publisher 
Station obtains working copies of the versions current at the time the documents 
were added to the project and uses those copies for translation. As a result, 
someone else may check out—and change—those same files by the time you are 
ready to stage and publish. 

Update Versions command
When you click Update Versions, Document Publisher Station reviews the status of 
all source documents in the FileNet repository and identifies any that have been 
checked out and revised since you first added them to your publication. It uses 
copies of the latest released versions of those documents for all subsequent 
translations (until you click Update Versions again). 

Clicking Update Versions on the toolbar updates all documents in your publication, 
no matter what is selected in the Publication Hierarchy or Contents pane. 
Alternatively, you can update all documents by selecting the root publication, right-
clicking, and choosing Update Versions from the popup menu that appears. 
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Likewise, to update selectively, select only the appropriate subpublication in the 
Publication Hierarchy pane or the Directory Item or document in the Contents pane. 
Then right-click and choose Update Versions from the popup menu. In that event, 
Document Publisher Station will check for new versions of only those source 
documents included in your selection. (You can select multiple documents by using 
the Ctrl key with the mouse button.) 

Note: You can also translate selectively. You can right-click a publication in the 
Publication Hierarchy pane and click Translate Publication on the popup menu. 
Alternatively, you can select source documents from a particular publication in the 
Contents pane, right-click, and choose Translate Selected from the popup menu.

Updating a linked publication
A linked publication cannot be changed from within a master project. It must be 
opened separately, by itself, in Document Publisher Station, and the Update 
Versions command used to update the contents of the project. Once a linked 
publication is updated, you must use the Update Versions command the next time 
you open the master project in order for changes to the linked publication to be 
reflected in the master project.

Updating projects on FileNet Document Publisher Server
Updating occurs automatically when you schedule a project for translation on 
FileNet Document Publisher Server. For more information, see “Publishing in FileNet 
Document Publisher Server” on page 23.

Staging a project
Staging a project is the process whereby Document Publisher Station copies 
translated output from the file system to a staging area for the webmaster to review 
before the finally approved content is published to the web site (the publishing 
location).

You can, in fact, by-pass staging and go straight to publishing. But a review is 
advisable if only because there likely will be some features of your web site that you 
can check only once you have staged (or published) your project. For example, 
staging provides an opportunity to inherit document information from source 
documents and place it in your output web pages. It also would allow certain 
scripting behaviors to run on the web server (such as a dynamic include).

Setting staging options 
You must set staging options in order to stage your project. The staging options you 
set apply only to staged output. Once you have reviewed your staged web 
publication and are ready to publish, you must set publishing options for your 
published output. (Although you set the options separately, you should generally set 
them the same way.)

If, for a particular project, you set only staging options or only publishing 
options, any property values and security settings you choose to inherit will be 
inherited directly from the source documents. 
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If you set both staging and publishing options, the values and settings you 
inherit for published output will come from your staged output (which will have 
obtained them from the source documents).

If, however, you set both staging and publishing options but only publish—do 
not first stage—your project, then your output pages will not be able to inherit 
property values and security settings. Document Publisher Station (or 
Document Publisher Server) will try to inherit them from the staged output. It 
will fail to do so and will generate a publishing error. 

Staging to a FileNet repository 
The Publish command is the final command you will use during a typical session in 
Document Publisher Station. In reality, the final sequence is the five-part Update–
Translate–View–Stage–Publish. Once you have completed your final translation, you 
use the Stage command to copy all output files from your file system into an object 
store in FileNet Content Manager or a library in FileNet Content Services. Once you 
have reviewed the publication and are satisfied with it, you are ready to publish; 
that is, copy the translated output to a different object store in FileNet Content 
Manager or a library in FileNet Content Services (or go directly to a web server). In 
the process, Document Publisher Station fixes up all URLs with document IDs.

Before you stage or publish, you must first use Staging or Publishing Options to 

Designate locations for the staged or published output 

Apply property values to the staged or published output

Apply security settings to the staged or published output

Specify a URL format for fixing up document IDs

Let us first consider a simple situation in which you designate output locations, 
inherit both property values and security settings, and specify a URL format. Later, 
we will review additional options for applying property values and security settings, 
and also for fine-tuning their use within a project.

Note: For more on property values and security settings themselves, see related 
FileNet documentation.

In the following examples, we will look at what happens when you set staging 
options. You follow essentially the same steps to set publishing options.

To designate output locations

 1.  Click Staging Options on the Run menu to open the Staging/Publishing 
Options dialog box (see Figure 5-1).

 2.  From the Repository drop-down list, select FileNet Content Manager or 
FileNet Content Services.
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Figure 5-1  The Staging Options dialog box before libraries and folders have been specified for 
staged output in FileNet Content Services. 

 3.  Opposite the Pages field, click Browse to open the Output Document Location 
dialog box (see Figure 5-2).

Figure 5-2  The Output Document Location dialog box in Content Manager, where you select a folder 
for staged output. (The interface is different for Content Services.)

 4.  Select the appropriate folder in the FileNet repository for the staged output 
pages.

The Advanced panel is relevant only if you are publishing some or all of your 
output directly to a web server. (See “Outputting directly to a web server” on 
page 74.)

 5.  Click the Next button to open the Output Document Properties dialog box (see 
Figure 5-3).
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Figure 5-3  In the Output Document Properties dialog box, you decide whether to inherit (and possibly 
customize) property values for published output or to specify them, instead. 

 6.  Click Inherit from Source. 

With this setting you have decided to inherit property values from the source 
documents and apply them to output pages and graphics. You could still 
customize some of these values, if you want to. We will look at that option 
later.

 7.  From the Document Class drop-down list, select the document class you want 
to assign to non-FileNet documents. 

Since framesets, TOCs, and other reference pages are generated by FileNet 
Document Publisher Station, they have no property values to inherit. So you 
must assign a document class to such output in order to apply property values. 
The class will apply also to any associated files in the project.

Note: The object store in Content Manager or library in Content Services that 
you are publishing to determines the document classes available from the 
drop-down list.

 8.  Click Next. The Output Document Security dialog box opens, where you 
specify security settings (see Figure 5-4).
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Figure 5-4  The Output Document Security dialog box, with options for inheriting or specifying 
security settings, or doing both.

 9.  Click Inherit security settings from the source document, and then click 
Finish. (This is the simplest choice. We will examine the other options below.)

Document Publisher Station returns you to the Staging Options dialog box, as 
shown in Figure 5-5.

Figure 5-5  The Staging Options dialog box, once you have designated locations for staged output.

Using different output locations for graphics 
When you set publish options for pages, the designated output location is used 
automatically for graphics and Gallery graphics, too. (See the Staging Options dialog 
box in Figure 5-5.) 

You can choose a different folder (and library) for output graphics, if you want, and 
also for gallery Graphics. If you do so, you can also apply different property values 
and security settings for graphics and Gallery graphics. 

To change the output location for graphics or Gallery graphics, click the appropriate 
Browse button in the Publish Options dialog box and repeat the steps above to 
designate output locations. 
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To specify a URL format

Once you designate output locations and specify property values and security 
settings, you are not quite done. When Document Publisher Station checks 
published output into FileNet Content Manager or FileNet Content Services, it 
assigns an ID to each file. That is, it replaces all URLs for the output files with IDs, so 
that all links between your documents are preserved once you publish to the web 
site. 

You must specify a particular URL format to fix up the links, depending on where 
you publish to.

 1.  Click Details in the Publish Options dialog box to open the Publish Details 
dialog box (Figure 5-6).

 2.  From the Relative and Absolute drop-down lists, select the URL format most 
appropriate to your needs (see “Selecting a URL format” on page 65). 

Note: If you publish all output to FileNet Content Manager or FileNet Content 
Services, the default relative URL format is fine and you do not need to enter 
the Publish Details dialog box.

 3.  Click OK to return to the Publish Options dialog box. Click OK again to 
complete publish options and return to the main window. 

You are now ready to publish.

Figure 5-6  Publish Details, where you specify the appropriate URL format so that your web server 
can retrieve the output files from the repository.

Selecting a URL format 
When specifying publish options for a project, you must specify a URL format (see 
“To specify a URL format” on page 65).

When Document Publisher Station checks published output into a FileNet 
repository, it assigns a document ID to each file. That is, it replaces all URLs for the 
output files with document IDs, so that all links between your documents are 
preserved once you publish to your Web site.

You must specify a particular URL format to fix up the links, depending on where 
you publish to. By selecting the appropriate URL format, you will ensure that the 
individual pages and graphics of your published output remain linked at all times, no 
matter where they are accessed from.
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General rules

You will almost always need to specify a relative URL (but the default setting 
should be fine in most cases).

You will rarely need to specify an absolute URL.

FileNet will use only the information needed, based on your publishing needs. 
(For example, when your publishing situation is as outlined in Example 3, 
below, it only matters what displays in the Absolute text box.)

In some instances, you will need to identify a Web server URL, too (see the 
examples below).

Possible scenarios

Following are four examples of the situation you may be in when selecting a URL 
format to complete the setting of publish options for your project before publishing.

Example 1 — In the most common situation, you are publishing all your output to a 
FileNet repository and therefore all links between output pages and graphics take 
place in the same repository (possibly in different object stores or libraries). By 
selecting the following relative format, all links between the files will be preserved 
and FileNet will be able to access them.

Note: You may not require the full URL shown, but it will take care of all 
possibilities.

Example 2 — In this instance, you are publishing some of your output to the 
FileNet repository and some directly to a Web server; also, the files published to the 
server contain no links back to the repository. (A good example would be Gallery 
graphics, which you might want to place on a fast, unsecured server). Again, you 
would use the following relative format.

This time, however, you would also need to provide a Web server URL (a full path 
for the root of the published output) in the Web Server Location dialog box when 
you specify a file system location for the output published to the server.

Example 3 — Say you are again publishing some of your output directly to a Web 
server, but this time the files contain references to files in the repository. (You might 
have placed associated files in the same output folder as your Gallery graphics.) In 
that event, you need to specify a server address so that FileNet can retrieve files 
from the repository. In other words, you would need to provide an absolute format:

FileNet Content 
Manager

getContent?id=%%DOC%%&objectStoreName=%%LIB%%&objectType=document
&anchor=%%PT%%#%%PT%%

FileNet Content 
Services

doccontent.dll?library=%%LIB%%&id=%%DOC%%&anchor=%%PT%%#%%PT%%

FileNet Content 
Manager

getContent?id=%%DOC%%&objectStoreName=%%LIB%%&objectType=document
&anchor=%%PT%%#%%PT%%

FileNet Content 
Services

doccontent.dll?library=%%LIB%%&id=%%DOC%%&anchor=%%PT%%#%%PT%%
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You will need to edit the “servername” and “YourServerName” portion of the default 
URL. In addition to providing this absolute URL format, you will also need to provide 
both a physical location on the file system for the files published to the server and a 
Web URL address.

Example 4 — In the unusual case where you publish all your output directly to a 
Web server, you will need neither a relative nor an absolute URL. In effect, the 
Publish details dialog box can be ignored. (All the links are relative and no 
document IDs are being created in the FileNet repository.) And when you identify a 
file system location for the published output, you won’t need to provide a Web 
server URL, either.

Note: Any additional URL formats you enter in the Publish Details dialog box will be 
preserved by Document Publisher Station and will be available when you enter the 
dialog box in the future.

Confirming staging options 
Once you have specified locations for your output files, and also property values 
and security settings, and have selected a URL format, you have completed publish 
options for your project. Each time you click Stage on the Run menu, the Confirm 
Staging Options dialog box will open, so that you can confirm your options (see 
Figure 5-7). 

Figure 5-7  The Confirm Staging Options dialog box, containing information specified in the Staging 
Options dialog box. 

To accept the information, click OK. Document Publisher Station will stage to the 
specified library in FileNet Content Manager or Content Services or directly to a web 
server, as specified. To change any information, click Cancel and return to the 
Staging Options dialog box. (If, when you click Stage, you have not already specified 
the required information, the Staging Options dialog box will open instead.) 

If Document Publisher Station encountered problems during translation, the Unable 
to Publish dialog box will open when you click OK:

FileNet Content 
Manager

http://servername/Workplace/
getContent?id=%%DOC%%&objectStoreName=%%LIB%%&objectType=document
&anchor=%%PT%%#%%PT%%

FileNet Content 
Services

http://YourServerName/idmws/doccontent.dll?library=%%LIB%%&id=%%DOC%%
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If this happens, you must either correct the errors that occurred during translation 
(you can click View Log to identify the errors in the log file) or select the Publish 
with errors option in the Project Options dialog box (from the View menu).

Notes

Document Publisher Station stages and publishes incrementally. Say you have 
already staged and decide to update source documents and therefore the 
translated output. When you retranslate and click Stage, Document Publisher 
Station will copy only the revised output files from the file system to the library 
designated for staged output. It will preserve the original IDs in the process.

If you change property values or security settings, simply click Stage for these 
to take effect.

If, however, you change the output locations, Document Publisher Station will 
delete all published output from the old locations and create new files with new 
IDs in the new locations.

The Update Versions, Translate, Stage and Publish commands work differently 
when you schedule a publication for translation by Document Publisher Server. 
(See Chapter 3.)

Specifying properties and security for published output
Above, we explored a simple example of setting publish options for a project. We 
applied to the published output the property values and security settings inherited 
from the source documents. However, when you set publish options, you can

Customize the inherited property values

Specify, instead of inherit, property values

Specify, instead of inherit, security settings

Merge specified security settings with inherited ones

Finally, you can fine-tune property values and security settings at the publication, 
Directory Item, or document level in your project. Let us look at each, in turn.

Notes

When you inherit property values or security settings, ideally you should stage 
and publish to the library that contains the source documents. If you stage and 
publish to a different object store or library from the source, the object store or 
library you publish to should share those document classes. 

You might also consider creating a special document class (say “Web 
Publishing”) for all output files. This document class should have no required 
fields. In this way you will not disrupt the publishing process in FileNet 
Document Publisher. 
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To customize inherited property values

Instead of applying all inherited property values to your staged or published output, 
you might want to customize some of those values. 

 1.  In the Output Document Properties dialog box (see Figure 5-3), select Inherit 
from Source.

 2.  From the drop-down list, select the document class you want to associate with 
non-FileNet documents. (Remember: FileNet Document Publisher Station 
makes framesets, TOCs, and other reference pages during translation, so those 
files cannot inherit property values. This applies to associated files, too.) 

 3.  Click the Customize button to open the Customize Document Properties dialog 
box (see Figure 5-8). 

Figure 5-8  The Customize Document Properties dialog box lets you switch between the document 
classes used for your source documents and to customize each class, in turn. The above dialog box is for 
Content Manager. The dialog box is different in Content Services.

 4.  Under Document Class, select the class you want to edit. 

Note: The classes listed are those available in the object store or library you 
are publishing to. If you publish to one different from your source, it should be 
to an object store or library that has the same document classes.

 5.  Under Item Properties or Version Properties you can only customize those 
entries with the status Inherit or Set. You can right-click to toggle between the 
two options. 

Example: You may have a Comment property (not shown in Figure 5-8). You  
could right-click Inherit opposite the property in the Item Properties box and 
choose Set from the popup menu if you want to create an alternative comment 
to the one being inherited. Then, in the text box that appears, you could type 
the alternative comment to be used. If you wanted to suppress the original 
comment and not replace it with a new one, you could simply leave the text 
box empty. 

Example: In the Version Properties box, you have the option of right-clicking 
Inherit opposite Publish Status. If you change Inherit to Set, you could then 
select Publish instead of Draft from the drop-down list that appears 
immediately in the Value column.

 6.  Click OK to return to the Output Document Properties dialog box.
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 7.  Click Next to open the Output Document Security dialog box (see Figure 5-4) 
to finish setting publish options. 

Note: Reserved means that FileNet Document Publisher will set these values as 
part of the publish process, while ReadOnly represents properties that cannot be 
set explicitly. 

To specify property values

In the above example you inherited property values from your source documents 
and then customized some of those properties.

Since your documents could have different document classes, they conceivably 
could have a variety of property values. If you prefer to impose a single document 
class (and therefore a single set of property values) on all published output, you can 
do that, instead. Let us return to the Output Document Properties dialog box 
(Figure 5-3)

 1.  Select Specify.

 2.  From the Document Class drop-down list, select the Document Class you want 
to use for all published output. 

 3.  Click the Specify Property Values button to open that dialog box (Figure 
Figure 5-9).

Figure 5-9  The Specify Property Values dialog box is similar to the Customize Document Properties 
dialog box, except that you are editing a single document class. The above dialog box is for Content 
Manager. The equivalent dialog box in Content Services is slightly different. 

This dialog box is very similar to the Customize Document properties dialog 
box (Figure 5-8). Since you use a single document class when you specify 
property values, there is no need for a Document Class list.

Once again you can specify only properties with the Inherit status (toggling to 
Set, if you want to, and then specifying a value). 

Note: In this example, since Draft is the default value for the Publish Status 
property, it will be applied automatically to all non-FileNet output.

 4.  Specify those property values you want to for the document class selected for 
all published output. 
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 5.  Click OK to return to the Output Document Properties dialog box. Then click 
Next to open the Output Document Security dialog box to complete security 
settings there.

Note: While you customize (or specify) property values, you can still inherit security 
settings (as explained above). Alternatively, you may choose to specify or merge 
them, as explained next.

To specify security settings

In our simple example (above), we originally inherited security settings. In that 
event, all security settings in the source documents would automatically apply to the 
published output. Let us review what these three options in the Output Document 
Security dialog box (see Figure 5-10) actually mean. 

Figure 5-10  The three options in the Output Document Security dialog box allow for either inheriting 
security settings or specifying new ones—or doing both.

Use specified security settings — Security settings in the Security tab dialog 
of the Output Document Properties dialog box apply to all output files. (This is 
the default setting.)

Inherit security settings from the source document — Security settings for 
the individual source documents are used. If the security settings for a 
particular source document cannot be determined, settings in Output 
Document Properties dialog box will be used.

Merge specified security settings with settings inherited from the source 
document — Merges security settings from the source document with those 
set in Output Document Properties dialog for the output files. So if Jack is the 
Owner of the source documents and Jill is the Owner of the output files, 
merging the security settings would result in both Jack and Jill having access to 
the output files. And this will happen even if Jill is a Viewer of the source 
documents, because specified values take precedence over inherited ones. 

Note: In most instances, you will want to either specify or merge security settings. If 
the webmaster responsible for the published output simply inherits security 
settings, and the source documents have a Read Only setting, the webmaster may 
not have access to the published output if he does not have administrative 
privileges. 
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 1.  To specify security settings, with Use specified security settings selected, 
click the Specify Security Settings button to open the Output Document 
Properties dialog box (see Figure 5-11).

Figure 5-11  The Security tab dialog for Content Manager, where you specify security settings.  
Content Services offers similar properties.

 2.  Set the security for all output pages. (See your Content Manager or Content 
Services documentation for more information on security settings.)

 3.  Click OK to return to the Output Document Security dialog box. 

 4.  Click Finish. Document Publisher Station captures the information and returns 
you to the Staging Options dialog box (see Figure 5-5). The selected folder now 
displays in the Pages text box, and also in the graphics and Gallery graphics 
text boxes.

To merge security settings with inherited settings

A final option is to both inherit security settings and specify new ones—and merge 
both. 

 1.  Select Merge specified security settings… and then click the Specify 
Security Settings button to open the Output Document Properties dialog box 
(see Figure 5-11).

As you can see, you use the same dialog box to merge settings as to specify 
them. The difference is that this time the specified settings will be merged with 
the ones inherited, instead of replacing them.

 2.  Specify security settings and then click OK.

 3.  Click Finish.

To fine-tune property values and security settings

When you complete publish options for a project, you are treating all of your 
publication the same way for the output location selected. That is, the same 
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property values and security settings (whether inherited or specified) will be applied 
to all output pages and graphics for a given output location. 

That may be fine for most purposes. If you prefer, and as noted above, you can 
select a different output location for graphics and/or Gallery graphics and set 
property values and security settings unique to those output files. 

Yet another option is to fine-tune your publication by specifying different options for 
individual subpublications, Directory Items, or documents in your project. This is 
only possible when you have completed staging or publishing options.

Let us take a simple example of changing the settings for a single document. 

 1.  Right-click a source document in the Contents pane and choose Properties 
from the popup menu. The Document Properties dialog box opens. 

The dialog box now has a Publish Options tab. This tab displays only if you 
have already specified output locations, etc., in the Staging or Publishing 
Options dialog box.

 2.  Click Publish Options to open that tab dialog. (See Figure 5-12.)

Figure 5-12  The Publish Options tab dialog, which is available for subpublications, Directory Items, 
and individual source documents once you have set publish options for the project. 

You have two basic sets of options: pages and graphics. And within each, you 
have the opportunity to edit property values and security settings that will 
override those set for the project as a whole in Publish Options. (In each case, 
the Clear button will simply clear whatever override property values or security 
settings have been entered. In that event, the values and settings will revert to 
whatever is set at the next highest level in the hierarchy.)

The No overrides entries signify that no property values or security settings 
have been specified for this source document (or Directory Item or 
subpublication, as the case may be).
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 3.  Under Pages, click the Edit button opposite Properties to open the Output 
Document Properties dialog box.

Figure 5-13  This is the same dialog box you saw when you first set staging and publishing options. 
Now, you can set property values for the selected document (or subpublication or Directory Item) and 
these will override those values set for the project as a whole.

Notes

Once staging options have been set in the Staging Options dialog box, the 
Publishing Options tab shown in Figure 5-12 is now available for Directory 
Items and any subpublications, too, so you can fine-tune property values and 
security settings for those in the same way. (This is also true, of course, when 
you set publishing options in the Publishing Options dialog box.)

When you set publish override options in a subpublication, Directory Item, or 
individual source document, these options override options that have been set 
at a higher level in the hierarchy. Typically, this will mean that they override 
staging or publishing options set for the project as a whole. Conceivably, 
however, you could set options for a subpublication that are different from the 
project options, and then set options differently for a source document within 
that subpublication.

Although the Publish Options tab is available for the root publication (as well as 
all subpublications, Directory Items, and source documents), you should ignore 
it. You must always use the Publish Options dialog box to set publish options 
for the project as a whole.

Gallery graphics are dealt with only at the project level. Property values and 
security settings will be determined by your choice of output location in Publish 
Options and the document class you select when designating that location. 

Outputting directly to a web server
Above, we addressed publish options in the context of placing published output in 
FileNet Content Manager or FileNet Content Services. If you prefer, you can publish 
some or all of your output directly to a web server, instead. For example, you might 
want to place Gallery graphics on a fast, non-secure server.
74



FileNet Document Publisher The publishing process
 1.  In the Output Document Location dialog box (see Figure 5-14), select the 
check box under Advanced and click the Specify button.

Figure 5-14  Check the Publish Direct to a Web Server check box in the Advanced panel to send 
published output directly to a Web server. 

The Web Server Location dialog box (Figure 5-15) opens.

Figure 5-15  When publishing directly to a web server, you need to designate an output location for 
the output pages and graphics. You may also need to provide a web server URL as a means to access 
those pages and graphics.

 2.  In the Directory text box, enter the path for the shared network directory you 
want to use for your published output. Use a UNC path (as shown in Figure 5-
15), rather than a DOS path. 

If you are not sure of the location, click the Browse button to open the Select 
Directory dialog box, and then locate the shared drive and directory. (The UNC 
path of the selected directory will display in the Web Server Location dialog 
box if you start your search from Network Neighborhood.)

 3.  Click OK to return to the Web Server Location dialog box. 

 4.  In the Web URL text box, enter the full path for the Web URL that will allow the 
published output to be retrieved by FileNet IDM Web.

 5.  Click OK.

Notes

You may not always need to provide a web server URL. See “Selecting a URL 
format” on page 65 for more information.

When you publish output directly to a web sever, any property values and 
security settings associated with the source documents is discarded.
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Publishing a project 
Publishing a project is similar to staging one. In fact, you could, if you like, ‘stage’ 
directly to your web site. (However, you should not ‘stage’ to a publishing area if 
you have already staged to a staging area. See Note 1, below.) 

So setting publishing options is very similar to setting staging options (you work 
through the same set of dialog boxes). But remember: If you set both staging and 
publishing options but only publish—and do not first stage—your project, then your 
output pages will not be able to inherit security settings. Document Publisher 
Station will try to inherit them from the staged output. It will fail to do so and will 
generate a publishing error.

When you use the Publish command, Document Publisher Station places a copy of 
the translated output (which always resides on the file system) to the object store in 
FileNet Content Manager or library in FileNet Content Services designated for 
publishing. You should not be updating between staging and publishing, because if 
something has changed, you will probably want to translate your web publication 
one more time, and also stage it again, before you publish.

Notes

Document Publisher Station stages and publishes incrementally. Say you have 
already staged or published and decide to update source documents and 
therefore the translated output. When you re-translate your project and then 
stage or publish again, Document Publisher Station will copy only the revised 
output files to the location designated for staged or published output.

The Update Versions, Translate, Stage, and Publish commands work differently 
when you schedule a publication for translation by Document Publisher Server. 
For more information, see “Publishing in FileNet Document Publisher Server” 
on page 23.

Automating staging and publishing
You can use Document Publisher Scheduler to automate the staging and publishing 
of your web publication by scheduling your project to run on Document Publisher 
Server. 

If you want to both stage and publish the same project, you will want to leave some 
time between the staging of the project phases in order to allow time for the 
webmaster to review output in the staging area. 

As explained in Chapter 3, you can achieve this by setting up two tasks for the same 
project.
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CHAPTER 6

Setting project and application options

During project setup you may set options that can affect your output in a number of 
ways. You can always accept the default settings—they will be fine in most 
instances. And whatever options you set at any time, you can later change at any 
time. But you should be aware of the options available in FileNet Document 
Publisher. 

FileNet Document Publisher distinguishes between two types of options, as 
represented by two dialog boxes: Project Options and Application Options. 

“Project options” are saved with the project file. Changes apply only to the 
project open in Document Publisher Station at the time of the change. 

“Application options” are user-specific for a given machine. If multiple users 
share a machine and set different options, the options in effect will be those 
that have been set by the user who is currently logged on. 

Project options
To review project options, click Project Options on the View menu to open the 
Project Options dialog box (see Figure 6-1).

Some of the default settings for project options are shown in the figure. If you 
change any settings, the new settings will be saved to the project file and will apply 
to the current project only. On the General tab dialog, you can set the following 
options:

Figure 6-1  The Project Options dialog box, with the General tab dialog open. Here, you set options 
that are saved with the project file. That is, the settings move with the project and will apply, for 
example, if you schedule the project for translation by FileNet Document Publisher Server.
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HTML generation — Standard HTML (Latin-1) is supported by HTML. The optional 
Windows-specific character set offers a richer set of characters, but is advisable only 
if you know your users can display all the characters in their browser. (This option is 
not appropriate, for example, with Unix-based browsers.) These options should be 
used in conjunction with Output Character Set.

Output Character Set — The default set is Western (ISO-8859-1). Unicode 
(UTF-8), which is supported by HTML 4.0, offers the broadest range of characters 
for all browsers, except older ones (version 2.0 and earlier). It includes all the 
characters offered by the other options. 

Containing frame name — Used when your FileNet web publication will become 
part of an existing web publication. In that event, you should replace _top with the 
name of the frame your web publication will open in (otherwise, your FileNet 
publication will take over the whole browser window). All names used will be saved 
to the project file and will be available from the drop-down list in future.

Publish with errors — Used to publish with errors even when FileNet Document 
Publisher encounters problems during translation. The option is turned off by 
default. The option is designed especially for situations where a file in an 
unsupported format inadvertently has been added to a Directory Item. With this 
check box selected, FileNet Document Publisher will simply skip this file and 
complete the translation and publishing process as if the file was not in the 
Directory Item at all. (Its failure to translate the file will be noted in the Log file.)

No Script Support — Used to add text to display in the user’s browser when an 
output page contains scripts and the browser does not support them.

Note: This option is not generally required, because web publications built with 
FileNet Document Publisher will still function when scripting is turned off. The only 
time you might want to use this feature is when you have created a web publication 
that includes the Print button and you are not certain that all users will be able to 
use this functionality successfully.

On the File Naming tab dialog, you have the following options:

File names — An important setting where case sensitivity is an issue. Typically not 
an issue in a Windows environment but always an issue if you have a web site 
running on a Unix-based server. If that is the case, you should select Force all file 
names to lower case.

Output name prefix — Used to add a prefix to your staged or published output to 
help create predictable file names when publishing to Document Publisher Server. 
Using this option, you can more easily distinguish between published files in 
different projects.

Prefixes can be added at the project, publication, and Directory Item levels. FileNet 
Document Publisher adds the prefixes to the output files during translation. With 
this feature, you can use the same source document in multiple publications of the 
same project.

Example You could add document.doc to both Publication A and Publication B of a 
project if you apply a prefix to the output file in one of the publications. If you add a 
“test” prefix to Publication A, that file becomes testdocument.htm during 
translation, while the output file name for Publication B remains document.htm.

You can add multiple prefixes in a project. Prefixes are appended to each other, and 
the prefix assigned to the closest publication always takes priority over other 
publications.
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For example, your publication hierarchy and prefix settings are as follows:

Using the above example:

If you set prefixes for the Project, Publication 3, and Directory Item 4, the 
complete prefix appended to output files for the documents contained in the 
Directory Item would be P34.

If you set a prefix for the Project, Publication 2, Publication 3, and Directory 
Item 4, the complete prefix for the documents contained in the Directory Item 
would also be P34, since Directory Item 4 is not directly related to Publication 
2.

If you set a prefix for Publication 3 and Directory Item 4, without setting any 
other prefixes, the complete prefix for the documents contained in Publication 
3, except Directory Item 4, would be 3. The complete prefix for items 
contained in Directory Item 4 would be 34. There would be no prefix 
associated with items contained in the Project through Publication 2 levels.

The Map File / Print Publication tab dialog contains additional settings that are also 
saved to the project (see Figure 6-2):

Figure 6-2  The Map File/Print Publication tab dialog of Project Options, showing the default settings, 
which are essential for creating an XML Map file and enabling the Print functionality.

Map file — An XML file that describes the output of your project on your Web site. 
By selecting the second check box — Map file contains source file details — the 
Map file will reveal the hierarchy of your source documents. FileNet Document 
Publisher generates the Map file by default. It is required in order to enable the 
print functionality. 

Level Prefix

Project P

Publication 1 1

Publication 2 2

Publication 3 3

Directory Item 4 4
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Print publication — Necessary for identifying the script to be used in order for the 
Print icon (selected in Navigation) to work. Automatically entered by FileNet 
Document Publisher.

On the Repositories tab dialog of the Project Options dialog box (not shown), you 
have a single option: Output page naming. With standard naming (the default), 
FileNet Document Publisher simply takes the source document name and changes 
the extension to produce the output HTML page. Thus, Tutor.doc becomes 
Tutor.htm. The optional settings are relevant when using FileNet Content Services. 

Application options
To review application options, click Application Options on the View menu to open 
the Application Options dialog box (see Figure 6-3).

Figure 6-3  The Application Options dialog box, shown here with the Logging tab dialog open. 
Application options are user-specific for a given machine. If multiple users share a machine and set 
different options, the options in effect will be those that have been set by the user who is currently 
logged on. 

When you first enter the Application Options dialog box, you will see the default 
settings shown in Figure 6-3. These settings are user-specific on a given machine. If 
they are changed by a particular user, the new settings will apply to all projects run 
on the machine by the user logged on at the time of the change. You can set the 
following option on the Logging tab dialog: 

Logging — The translation log for your project. You can change the path and file 
name for the log file, if you want, and also the logging level. The default level is 4. 
Level 5 provides the most complete logging information. The log file will be reset 
after each translation (FileNet Document Publisher will create a new log file by 
writing over the old one), unless you change this setting. Note that you can produce 
the log file in either the HTML format (the default) or text format.

On the General tab dialog (see Figure 6-4), you can set options for the following:

Word processor default character style name — Important when you are using 
Microsoft Word. Default Paragraph Font is the name of the default character style in 
Word that provides the font for the underlying paragraph style of all styles in every 
Word template. FileNet Document Publisher recognizes this name and does not 
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import the style. As a result, you can format your publication without fear of the 
default character style overriding your settings. 

If you are using a version of Word in a language other than English, you need to 
enter the equivalent of Default Paragraph Font in this text box. Any entry you make 
will be saved and will be available from the drop-down list in future.

Default output extensions — Generally, you will always want to use either htm 
(the default) or html as the extension for your output HTML pages. Ideally, any 
change to this setting should be made during project setup, because the change will 
apply only to new source documents added to the project after the change is made. 
(The wml extension would be used for any WML projects you create. For more 
information on WML projects, see “Creating a WML Project,” a PDF manual to be 
found in the Documentation folder of your installed directory, and also on the CD.)

Figure 6-4  The General tab dialog, where you specify the Default Paragraph Font for the language 
version of your word processor. You can also set the default output extension for your projects.

Default output file names — The default setting is to use the file name of the 
source document for the output file name. Click Use this property file name if you 
prefer to use a metadata property for files from FileNet Content Manager or Content 
Services. You can also choose to strip the file extension from the original file name 
at the same time.

Dialogs — The Dialogs tab dialog in the Application Options dialog box (Figure 6-5) 
lets you toggle between showing and hiding various screens and cautions in FileNet 
Document Publisher. 

Most are turned on by default when you first install FileNet Document Publisher. 
The only exception is the Show Project Type selection dialog check box. You can 
use this check box to toggle between creating an HTML or WML project. When you 
select this check box, the next time you start a new project in FileNet Document 
Publisher, the New Project Type dialog box will open, to let you choose between 
starting an HTML or WML project.

With Show Selective Incremental Translation dialog selected, you can right-click 
a publication in the Publication Hierarchy pane and choose Translate Publication 
from the popup menu to open the Selective Incremental Translation dialog box. 
Here, you can select individual publications and files to be translated. (TOCS do not 
appear in this dialog box, because TOCS—and framesets—are always updated with 
each translation.) 
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You can also open this dialog box by right-clicking an individual source document in 
the Contents pane and choosing Translate Selected from the popup menu. In 
either case, you can confirm (or change) your selection before translating.

Figure 6-5  The Dialogs tab dialog of the Application Options dialog box, where you can choose to 
show or hide certain dialog boxes.

FileNet Document Publisher Server
Unless you are using FileNet Document Publisher Station as a standalone 
workstation, you are most likely using the server, FileNet Document Publisher 
Server, to automate the translation process. By saving all the project options listed 
above to your project file, all the options that affect output can now travel with the 
project when you schedule it for translation by the Server. This is also true if you 
move the project and run it on any machine other than the one on which it was 
created.

Viewer options

Let us quickly review the viewer options. You need to have Microsoft Internet 
Explorer version 4.0 or higher installed on your machine in order for Document 
Publisher Station to run the Preview windows found in the Choose Template and 
Edit Template dialog boxes. 

These preview windows show only a temporary translation of the source document 
that you are editing. Since some effects are browser-dependent, the web page you 
see in the Preview window in these two dialog boxes may not match exactly the web 
page you view in your web browser once you formally translate the source 
document. 

Note: You will only be able to preview a source document in the Choose Template 
dialog box if (a) the Auto check box is selected, and (b) the document in the FileNet 
repository has a Publish Status property.

Whichever viewer you set as your default viewer will open whenever you formally 
translate your source documents and click the View button on the large toolbar to 
view the web publication you have just created. You can associate additional web 
browsers with FileNet Document Publisher and have all of them available for use. 
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And you can easily switch between browsers to view your web publications. You can 
also associate utilities such as Notepad. To add viewers, choose Setup from the 
Viewers menu, and then click Add in the Viewers Setup dialog box to locate and 
select the executable of the browser you want to use (see Figure 6-6). 

All the browsers you select for use in FileNet Document Publisher are available from 
the Viewers menu. You can also right-click the View button on the large toolbar to 
choose a browser from the popup menu that displays your viewer options. And you 
can choose Launch Viewer from the Viewers menu to launch your default viewer.

If your publication is unframed, you can view a specific source document in your 
browser by selecting that document in the Contents pane and then clicking View. (If 
none is selected, the browser will display the first document in your publication.) If 
your publication is framed, the browser will display the frameset for the publication 
selected in the Publication Hierarchy pane. (It will open the first body page of the 
frameset, no matter which source document is selected in the Contents pane.) If no 
publication is selected, the browser will display the frameset of the root publication.

Figure 6-6  The Viewers Setup dialog box. 
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APPENDIX A

File formats and translation

FileNet Document Publisher translates source documents from major word 
processing, spreadsheet, and presentation software programs, as well as those in 
other common file formats. It converts graphics in many different formats. In fact, 
FileNet Document Publisher can convert over 225 different document and graphics 
formats.

In addition, FileNet Document Publisher accepts input files in HTML, XML, and PDF 
formats. For more information on how FileNet Document Publisher treats these files 
and recognizes them in your web publication, see “HTML, XML, and PDF as input 
files” on page 90. And for information on how a graphic can be added to a 
publication as a source file, see “Graphics as input files” on page 91.

You may also want to preserve files that are in special formats that you use to create 
your Web site. FileNet Document Publisher can pass through such files without 
modification and place them in the appropriate output directory so that they are 
recognized as part of the project. They can then be referenced from within the 
project and even promoted to a publication’s TOC. See “Passing through source 
documents without conversion” on page 91.

File formats
FileNet Document Publisher can translate over 225 file formats. The following table 
lists the major text formats supported:

Application / Format Version

Word processing - DOS

ANSI Text (7 & 8 bit) all versions

ASCII Text (7 & 8 bit) all versions

DEC WPS Plus (DX) through 4.0

DEC WPS Plus (WPL) through 4.1

DisplayWrite 2 & 3 (TXT) all versions

DisplayWrite 4 & 5 through 2.0

Enable 3.0, 4.0, 4.5

First Choice through 3.0

Framework 3.0

HTML through 3.0

IBM FFT all versions

IBM Revisable Form Text all versions

IBM Writing Assistant 1.01

Lotus Manuscript through 2.0

MASS11 through 8.0
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Microsoft Word through 6.0

Microsoft Works through 2.0

MultiMate through 4.0

Navy DIF all versions

Nota Bene 3.0

NovellWordPerfect through 6.1

Office Writer 4.0 through 6.0

PC-File Letter through 5.0

PC-File+ Letter through 3.0

PFS:Write A, B, C

Professional Write through 2.1

Q&A 2.0

Samna Word through IV+

SmartWare II 1.02

Sprint 1.0

Total Word 1.2

Unicode Text all versions

Volkswriter 3 and 4 through 1.0

Wang PC (IWP) through 2.6

WordMARC through Composer+

WordStar through 7.0

WordStar 2000 through 3.0

XyWrite through III Plus

Word processing - Windows  

Adobe FrameMaker (MIF) 6.0

Corel/Novell WordPerfect through 12.0

Hangul 2002 (text only)

JustSystems Ichitaro 5.0, 6.0, 8.0 through 13.0, 2004

JustWrite through 3.0

Legacy through 1.1

Lotus Ami/Ami Professional through 3.1

Lotus WordPro (Intel platforms) 96 through Millennium Edition 9.6

Microsoft Rich Text Format (RTF) all versions

Microsoft Word through 2003

Microsoft WordPad all versions

Microsoft Works through 4.0

Microsoft Write through 3.0

Novell Perfect Works 2.0
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Professional Write Plus 1.0

Q&A Write 3.0

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

Unicode Text all versions

WordStar 1.0

Word Processing - Macintosh  

MacWrite II 1.1

Microsoft Word 3.0, 4.0, 98, 2001, 2004

Microsoft Works through 2.0

Novell WordPerfect 1.02 through 3.0

Word Processing - Unix  

Star Office Writer Version 5.2

Spreadsheet  

Enable 3.0, 4.0, 4.5

First Choice through 3.0

Framework 3.0

Lotus 1-2-3 Charts (DOS/Windows) through 5.0

Lotus 1-2-3 (DOS/Windows) through 5.0

Lotus 1-2-3 (OS/2) through 2.0

Lotus 1-2-3 for SmartSuite 97 through Millennium 9.6

Lotus Symphony 1.0, 1.1, and 2.0

Microsoft Excel Charts 2.x through 7.0

Microsoft Excel (Mac) 3.0 through 4.0, 98, 2001, 2004

Microsoft Excel (Windows) 2.2 through 2003

Microsoft Multiplan 4.0

Microsoft Works (Mac) through 2.0

Microsoft Works (Windows) through 4.0

Microsoft Works (DOS) through 2.0

Mosaic Twin 2.5

Novell Perfect Works 2.0

PFS:Professional Plan 1.0

Quattro Pro (DOS) through 5.0

Quattro Pro (Windows) through 12.0

SmartWare II 1.02

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

SuperCalc 5 4.0
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VP Planner 3D 1.0

Presentation  

Corel/Novell Presentations through 12.0

Harvard Graphics (DOS) 2.x, 3.x

Harvard Graphics (Windows) all versions

Freelance (Windows) through Millennium 9.6

Freelance (OS/2) through 2.0

Microsoft PowerPoint (Windows) 3.0 through 2003 

Microsoft PowerPoint (Mac) 4.0 through 2001, 2004

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

Databases  

Access through 2.0

dBASE through 5.0

DataEase 4.x

dBXL 1.3

Enable 3.0, 4.0, 4.5

First Choice through 3.0

FoxBase 2.1

Framework 3.0

Microsoft Works (Mac) through 2.0

Microsoft Works (Windows) through 4.0

Microsoft Works (DOS) through 2.0

Paradox (DOS) through 4.0

Paradox (Windows) through 1.0

Personal R:BASE 1.0

Q&A through 2.0

R:BASE 5000 through 3.1

R:BASE System V 1.0

Reflex 2.0

SmartWare II 1.02

Other  

Executable (EXE, DLL) no specific version

Microsoft Outlook Express (EML)

Microsoft Outlook Folder (PST) 97, 98, 2002, 2003

Microsoft Outlook Message  (MSG) all versions

Microsoft Project 98 through 2003 (Datasheet view)

Microsoft Visio 2003
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Graphics formats
The following table summarizes the major graphics formats supported by FileNet 
Document Publisher. All embedded graphics in the source documents are converted 
according to the default setting in the Graphics tab dialog of Formatting. The 
options are GIF, JPEG, PNG, and BMP. (The WBMP format is intended for web 
pages that will be viewed in an Internet-enabled device.) 

You can use any two or three or even all four of the options, assuming that the 
graphics are associated with different elements. Any linked GIF, JPEG, PNG, or BMP 
graphics in the source documents are “passed through” by FileNet Document 
Publisher during translation. All other linked graphics are governed by the settings in 
Formatting.

Mime Internet mail format

vCalendar Scheduling 1.0

vCard Electronic Business Card Versit 2.1

WML specification 5.2

Format Version

Adobe Photoshop* (PSD) 4.0

Adobe Illustrator* (AI) through 7.0, 9.0

Adobe FrameMaker Graphics (FMV) vector/raster through 5.0

Adobe Acrobat* (PDF) 2.1, 3.0 through 6.0

Ami Draw (SDW) Ami Draw

AutoCAD* Interchange and Native 
Drawing Formats

DXF and DWG

AutoCAD Drawing 2.5, 2.6, 9.0 through 14.0, 2000i, 2002

AutoShade Rendering (RND) 2.0

Binary Group 3 Fax all versions

Bitmap (BMP, RLE, ICO, CUR, OS2 DIB, 
WARP)

all versions

CALS Raster (GP4) Type I and II

Corel Clipart format (CMX) 5 through 6

Corel Draw (CDR) 3.x through 8.x

Corel Draw* (CDR with TIFF header) 2.x through 9.x

Computer Graphics Metafile (CGM) ANSI, CALS, NIST 3.0

Encapsulated PostScript (EPS) TIFF header only

GEM Paint (IMG) no specific version

Graphics Environment Manager Metafile 
(GEM)

bitmap and vector

Graphics Interchange Format (GIF) all versions

Hewlett Packard Graphics Language 
(HPGL)

2.0
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IBM Graphics Data Format (GDF) 1.0

IBM Picture Interchange Format (PIF) 1.0

Initial Graphics Exchange Specification* 
(IGES)

5.1

JFIF (JPEG not in TIFF format) all versions

JPEG (including EXIF) all versions

Kodak Flash Pix (FPX) all versions

Kodak Photo CD (PCD) 1.0

Lotus PIC all versions

Lotus Snapshot all versions

Macintosh PICT1 and PICT2 bitmap only

MacPaint (PNTG) no specific version

Micrografx Draw (DRW) through 4.0

Micrografx Designer (DRW) through 3.1

Micrografx Designer* (DSF) Windows 95, 6.0

Novell Perfect Works (Draw) 2.0

OS/2 PM Metafile (MET) 3.0

Paint Shop Pro 6 (PSP) Windows only: 5.0 through 6.0

PC Paintbrush (PCX and DCX) all versions

Portable bitmap (PBM) all versions

Portable Graymap (PGM) no specific versions

Portable Network Graphics (PNG) 1.0

Portable Pixmap (PPM) no specific version

Postscript* (PS) Level II

Progressive JPEG no specific version

Sun Raster (SRS) no specific version

StarOffice /
Open Office Draw

5.2, 6.x, 7.x /
1.1 (text only)

TIFF through 6

TIFF CCITT Group 3 & 4 through 6

Truevision TGA (TARGA) 2

Visio (preview) 4

Visio 5, 2000, 2002

WBMP no specific version

Windows Enhanced Metafile (EMF) no specific version

Windows Metafile (WMF) no specific version

WordPerfect Graphics (WPG and WPG2) through 2.0, 7, 10

X-Windows Bitmap (XBM) x10 compatible
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The asterisk (*) denotes a high-end graphics format. All high-end graphics formats 
are provided by FileNET “as is,” without representations or warranties.

Translation issues
In this section:

OLE Object support

HTML, XML, and PDF as input files

Graphics as input files

Passing through source documents without conversion

Disk space

Anti-virus software

Output HTML pages

OLE Object support
If a source document created in Microsoft Word or Excel contains an embedded 
OLE object, FileNet Document Publisher will, if possible, export a copy of that 
object. It will create not only an output graphics file as a graphical representation of 
the object, but also a file for the linked object itself. It will then attempt to link the 
graphical representation of the OLE object in the output web page to that file. If that 
object type is supported by the browser setup, clicking the graphic will display the 
object in its native format (assuming you have the appropriate application installed 
on your machine). See also “Preserving links to embedded OLE objects,” in online 
Help. 

Note: FileNet Document Publisher cannot export multimedia objects (only the 
graphical representation of the file will display in the output page). Also, to enable 
this functionality, you must check Preserve links to embedded OLE objects 
where possible on the Options tab dialog of Globals for the template you associate 
with your source documents. And in the source document itself, be sure to turn off 
the options Float over text and Link to file for the object.

HTML, XML, and PDF as input files
In addition to creating HTML and XML output files, FileNet Document Publisher can 
also accept these formats as input files. And it can incorporate PDF files into a web 
publication by creating a page linked to the original file, which can be opened in its 
native format if the user has Adobe Reader installed. You can also set pass-through 
conversion options for these file types to add the files to your project in their 
original format, using their original file names and extensions, and creating a direct 
link to the file from the publication TOC.

HTML input files — When HTML files are added to a project as source documents, 
the HTML files remain intact, but you can make them consistent with other web 

X-Windows Dump (XWD) x10 compatible

X-Windows Pixmap (XPM) x10 compatible
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pages in the project by enhancing them with a common background, a title, and 
navigation buttons.

When you translate files that have linked graphics, such as HTML files, the graphics 
are copied to the output directory. If you have two HTML source documents that 
have links to different graphics with the same name, the resulting graphics file 
names will be incremented to keep them from overwriting each other.

Note: When FileNet Document Publisher translates an HTML file, information in the 
<HEAD> of the file, including Meta tags, will be passed through unchanged. The 
element Title will be assigned to any titles in the Head. If you want to add an HTML 
file to your publication in its original format, such as to preserve background and 
link colors set in the file, you may want to select the pass-through conversion 
option. See “Passing through source documents without conversion” on page 91 for 
more information.

XML input files — These will be passed through completely unchanged to the 
staging or publishing area. Their existence will be noted in the TOC and in the XML 
Map file. How different browsers (or other viewers) render the file may vary. You can 
also set a pass-through conversion option for an XML document or Directory Item, 
explained in “Passing through source documents without conversion” on page 91. 
The XML file is treated the same whether you add it as an input file or set the pass-
through conversion option for the file.

PDF input files — The original files are passed through to the staging or publishing 
area. FileNet Document Publisher creates a page as a placeholder for the PDF file at 
the appropriate point in the publication. This page is linked to other output pages, 
according to its order in the translation process. In addition, the page contains a link 
to the PDF file (FileNet Document Publisher uses the name of the file as an 
identifier). When the user clicks the link, the PDF file will open in its native format in 
Adobe Reader, assuming that application is installed on the user’s machine.

Note: You can also link a PDF file directly from the TOC, instead of from a separate 
web page, so the user can open the PDF file from the TOC. See “Passing through 
source documents without conversion” on page 91 for more information. 

Graphics as input files
Graphics files can be selected as input files in FileNet Document Publisher. When 
FileNet Document Publisher converts a graphics file, it will generate a separate 
HTML file with navigation buttons and a link to the graphic (just as it does for a 
source document) so the graphic displays on the web page. FileNet Document 
Publisher also handles multi-page graphics. Multi-page images will be displayed in a 
single HTML file with a title based on the source file name. The title will be 
represented as a Heading 1 element, which you can use to split a multi-page image 
into multiple HTML files.

If you want to add a complex graphic to your publication that remains in its original 
format, you may want to use the pass-through conversion option, described below. 

Passing through source documents without conversion
The files you use to create a web publication may include those in special formats 
(such as AVI or PDF) that you want FileNet Document Publisher to preserve. FileNet 
Document Publisher can pass through such files and place them in the appropriate 
output directory so that they are recognized as part of the project. They can then be 
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referenced from within the project and even promoted to a publication’s Table of 
Contents (TOC).

You can set pass-through conversion options for Directory Items and documents.

When you set pass-through conversion options for a document, that source 
document is passed through to the output folder in its original format, using the 
original file name and extension. You can then reference the file in your project. You 
can also promote the document to the publication TOC, creating a direct link from 
the TOC to the file.

When you set pass-through conversion options for a file, that file does not contain 
navigational buttons and background colors that may be set for other web pages in 
your web site. This can be useful if you want to link to a PDF file directly from the 
TOC so the user can open the PDF file from the TOC. (In this case, the user will have 
to have Acrobat Reader installed on his or her machine. Other files you pass 
through may require other applications to be available on the user’s machine.) 

When you set pass-through options for a Directory Item, the documents matching 
the criteria you specify are passed through to the output folder during translation in 
their original format, using their original file names and extensions. 

You can set conversion options for one file type, multiple file types, or all documents 
in that directory. You could use this feature to place all of the files you want to 
include in your publication without translation into one central location. 

Notes

To reference a passed-through document in the TOC, promote Title (System), 
which is the only element available for TOC promotion when using this option.

If you do not promote the title of a passed-through document to the TOC, the 
file is essentially the same as an associated file in FileNet Document Publisher. 
See “Associating a file with a publication” in the Help system for more 
information on associated files. 

If you choose to treat the files in a Directory Item in a manner similar to 
associated files, be sure to add the Directory Item to a publication that 
contains no TOC and no framesets and use a template that contains no 
promotion to reference pages.

You can also include a PDF file in a web publication as a web page that 
contains a link to the original file. See the previous section, “HTML, XML, and 
PDF as input files” on page 90 for more information.

Disk space
If you experience performance difficulties, especially in displaying previews, check to 
see that you have adequate disk space. Adequate disk space depends upon the 
number of documents you are trying to translate and their complexity. At the very 
least, a range of 25-50 free megabytes of disk space is highly recommended for 
translation purposes—though you may require much more for a large project. This 
disk space must be on the drive that contains your Temp directory. Of course, you 
will also require disk space for your translated output.

Anti-virus software
Conflicts can occur with anti-virus software if you frequently run translations that 
can result in large log files. With frequent translations, the log file may be more or 
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less continuously updated. Since the log file is frequently changing, it can attract a 
lot of attention from anti-virus software. As the anti-virus software attempts to 
review the entire file, more changes could get made to the file. This results in a 
deadlock situation, where the anti-virus software cannot catch up.

We recommend that you use a unique extension for the log file and set your anti-
virus software to ignore files of that extension type. (Choose Application Options 
from the View menu to set logging options.)

Output HTML pages
If you delete a source document from a project, the history file will also be updated 
but the output HTML file from the last translation will not be removed. It is 
recommended that you delete all files from your output directories before carrying 
out your final translation.

About styles in Excel and PowerPoint
The following may be helpful if you are creating web pages from spreadsheets 
created in Microsoft Excel or presentations created in Microsoft PowerPoint.

Note: FileNet Document Publisher ships with templates specifically designed for 
source documents created in Microsoft Excel and Microsoft PowerPoint:

MS Excel and MS Excel TOC

MS PowerPoint and MS PowerPoint TOC

Ideally, you should associate these templates with your Excel and PowerPoint 
source documents, respectively.

Styles in Microsoft Excel
Styles in Microsoft Excel are based on the formatting of the cell. (“Style” here 
relates to the treatment of numeric values, not to formatting attributes that apply in 
the case of a Word file, for example.) The Heading 1 style is created by FileNet 
Document Publisher; the others are default styles in Excel:

Heading 1 

Comma

Comma [0]

Currency

Currency [0]

Normal

Percent

Heading 1 represents the name of each worksheet. By default, FileNet Document 
Publisher creates this style and uses it to split a spreadsheet during translation in 
order to create a separate HTML file for each worksheet. 

Creating a new style in Microsoft Excel

To create a new style in Microsoft Excel, open your spreadsheet and do the 
following:
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 1.  Select a cell that has the combination of formats you want to include in the new 
style.

 2.  From the Format menu, choose Style to open that dialog box.

 3.  In the Style Name text box, type a name for the new style.

 4.  Click OK.

The new style you have created can now be applied to any selected cells in your 
spreadsheet. It will be saved with the spreadsheet and used to create a new 
element when the spreadsheet is imported. If the spreadsheet is already part of a 
project in FileNet Document Publisher, you can simply open that publication, right-
click the spreadsheet in the Contents pane, and choose Import and then Styles. 

Styles in Microsoft PowerPoint
When you add a Microsoft PowerPoint presentation to a project, FileNet Document 
Publisher imports the styles in the slides that form the presentation. 

In general, FileNet Document Publisher translates content relating to the following:

Title

Body text

Top-level text objects (the content of text boxes that are not inserted in 
graphics)

The following table summarizes styles available after a PowerPoint presentation has 
been added to a project, and shows how the styles are mapped in FileNet 
Document Publisher. 

Style Element Comment

Automatic Heading Heading 1 Style created by FileNet Document Publisher where a slide 
has no title or heading. It is applied to the title and also 
creates a slide number, based on the slide’s position in the 
presentation (e.g., “Slide 7”).

Center Title Heading 1 A PowerPoint style used for the title of a Title slide.

Heading 1 Heading 1 Style created by FileNet Document Publisher and applied to 
the title of a regular slide.

Slide Slide Style created by FileNet Document Publisher for all slide 
images (thus allowing them to be turned on or off in the 
output web pages).

Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body element.

Center Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body element.

Half Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body element.

Quarter Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body element.

Note 1 to 5 Note 1 to 5 Notes displayed in PowerPoint’s “Speaker Notes” view.

Text 1 to 5 Text 1 to 5 Text added by user; only top-level text objects are translated

Notes Footer Ignored by FileNet Document Publisher

Notes Header Ignored by FileNet Document Publisher

Slide Footer Ignored by FileNet Document Publisher
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APPENDIX B

Templates and graphics sets

FileNet Document Publisher ships with a set of templates in Default.tcp, the default 
project file, which are available each time you start a new project:

there are 28 graphics Sets in FileNet Document Publisher

in addition to the standard navigation buttons, all the graphics Sets include 
Print, Link to Source, Top of Project, and Specific Page links

You can view the graphics Sets in the Gallery, in the Sets mode. The templates are 
listed in the Manage Templates dialog box (except for the default reference page 
templates—Default TOC, Default LOF, Default LOT, and Default Index—which you 
select in the Add Reference Page dialog box when you create a new template). 

Note: A second default project file, DefaultWML.tcp, is used to create WML 
projects. (Like Default.tcp, it resides in the ..\Resources\en folder, with a copy 
available on the CD-ROM.) DefaultWML.tcp has a far more limited selection of 
templates. For more information, see “Creating a WML Project” in the 
Documentation folder of your directory.

In summary

There are 19 body templates. 

The Blank template contains no styles, ranks, patterns, or metadata, or any of 
the other default settings noted below. This is the template to use if you simply 
want to “pass through” a source document to see how it looks without any 
special formatting (and this is the template that FileNet Document Publisher 
uses when you create a new template and do not base it on another template). 

14 other general-purpose templates have various default settings (promotion, 
splitting, etc.), as noted in the second table below. These templates also have 
complementary TOC, and Index templates. (The same graphics Set is 
associated with all three templates in each group to ensure a consistent look 
throughout your publication.)

The 4 remaining body templates are designed for source documents created in 
spreadsheet and presentation applications. They have a complementary TOC 
template, but no Index. 

Templates with “CSS” in their name have Cascading Style Sheets turned on. 

Templates and graphics Sets in Default.tcp
The table below lists all 19 body templates in the default project file. The graphics 
Set listed for each body template is also associated with the TOC and Index 
templates, where available. (There are 28 graphics Sets in FileNet Document 
Publisher, so not all are used.

Template Graphics Set

Academy Aqua Weave

Acclaim CSS Investment
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Default settings for 14 general-purpose templates
Following is a list of the default settings for the 14 general-purpose body templates. 
This is not necessarily a complete list of the settings. If you decide to use any of 
these templates, you should check the template before using it.

Account Clearing House

Adagio CSS Gray Tab

Administration Planner

Analysis Grouted Tiles

Archive CSS Scalloped

Blank

Business Blue Bevel

Ceremonial Blue Mexico

Courtesy CSS Cranberry Script

Executive Gray Tab

Introduction CSS Blue Peach

Lotus 1-2-3 Royal Cloth

Lotus Freelance Olive

MS Excel Skill Set

MS PowerPoint Maroon Sand

Purple Frost Lilac Spiral

Retrofied! CSS Salmon Retro

Feature Default Setting

Graphics Set See table above

Elements promoted to TOC Title and Heading 1

Treatment of elements on TOC Title flush left, Heading 1 indented

Split On Heading 1

Fonts Take from Source, Arial, or Verdana

Navigation buttons in Body Previous Page, Next Page, TOC, and 
Index (TOC and Index display only if your 
publication has a TOC and Index)

Navigation buttons in TOC None

Navigation buttons in Index None; Index may contain an Element 
Text Bar

Navigation buttons in Query None

Ranks Lowest 1, Title, Lowest 2, Heading 1

Character patterns HTTP, Weblink, Email

Template Graphics Set
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Default settings for 4 specialized templates
The following table lists the four specialized templates for use when the source 
documents were created by using one of the spreadsheet or presentation 
applications shown. See Appendix A, “File formats and translation” on page 84, for 
more information on using these applications with FileNet Document Publisher.

Template guidelines
Here are a few guidelines to consider when managing templates:

The templates in the default project file are simply a starter list. If you use any 
of them, it would be best to first review the template settings to confirm what 
is listed here and to identify any settings that may not be listed. 

If you use any, it would also be best to create a new template based on the 
template you want to use—giving it a unique name in the process. That way, 
there will be no danger of ever overwriting the new template.

When you rename a template, it is best to do so in the Manage Templates 
dialog box, which displays the underlying name of each template. This name 
will be retained in the template even if you rename the template as you export 
it or rename the template file in Windows Explorer. When you import a 
template into a project, FileNet Document Publisher recognizes the underlying 
template name and compares it to the list of templates already in the project. 
If there is a match, you can either overwrite the existing template or rename 
the one you are importing. 

Metadata Keywords

Imported graphics Converted to Gifs; no alignment

Cascading Style Sheets (CSS) Turned on for those templates with 
“CSS” in their name

Link colors Specified, but vary with template

Template Comment

Lotus 1-2-3 No ranks or metadata.

Lotus 1-2-3 TOC

Lotus Freelance Default styles: Automatic Heading, Heading 1, Normal, 
Slide, and Speaker Notes.

Lotus Freelance TOC

MS Excel No ranks or metadata.

MS Excel TOC

MS PowerPoint Includes a number of default styles not assigned to 
elements: Body #1, Body #2, etc.; Center Body 1, Center 
Body 2, etc. See Appendix A for more information.

MS PowerPoint TOC

Feature Default Setting
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Project files can be quite large (even when zipped). If you want to keep project 
files small, you might want to delete those templates you are not using. 
Alternatively, you can edit the project file by exporting most of the templates 
and “parking” them in a safe place. You can then simply import them as you 
need them. You might want to do this with the template files you create as well 
as the ones supplied by FileNet Document Publisher. Of course, with FileNet 
Document Publisher’s linking functionality, you can always link to a “parked” 
(external) template. However, you will have to import the template into a 
project in order to edit it.

Any templates you have been using with a previous version of FileNet 
Document Publisher can still be used when you import a 6.5 (or earlier) project 
file into FileNet Document Publisher 7.0. You can also import old templates 
into the new default project file. (You will first need to export those templates 
from the old projects and import them into the default project file. Chapter 2 of 
the Installation Guide explains how to edit the default project file.)
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Index
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Add menu 7
adding a Directory Item from FileNet Content 

Services 41
anti-virus software when translating 92
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default character style 80
default output extension 81
logging 80

Application Options dialog box 80
associated files

checking into FileNet Content Services 38
passing through 92

asterisk after a document name 54

B
Blank template 95
body page

defined 18
template 95

C
compound document

adding to a project 39
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Include children of compound documents option 

43
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types of 39
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conversion, passing through source documents 91
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D
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templates in 95
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Project Options 7, 77
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Update Versions 50
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dynamic 43
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Include subdirectories option 39
setting an output extension for 42
setting pass-through conversion options for 92
specifying file formats for translation 43
specifying options for 43
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adding from a FileNet repository 38
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assigning Publish status to 51
creating a working copy for translation 38
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specifying a version 50, 51
specifying a version in a FileNet repository 52
specifying a version in FileNet Document Publisher 

Station 53
specifying the newest published version 51
text formats supported 84
translating 47
updating 49
updating selectively 60
with asterisk after its name 54
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Draft status
adding custom feature 55
assigning to a document 53
using 53

dynamic Directory Item
compared with Folder Import wizard 45
defined 44
updating 50

E
Edit menu 7
editing process 15
element

defined 20
explained 15, 16

F
file formats

specifying for translation in Directory Items 43
supported 84

File menu 6
FileNet Document Publisher

supported graphics formats 84
supported text formats 84

FileNet Document Publisher Scheduler 22
FileNet Document Publisher Server

project options when using 82
versioning the project file 24

FileNet Document Publisher Station
Add a Document wizard 5
associating a web browser 82
Folder Import wizard 7
online Help 11
specifying a document version in 53
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adding a compound document 39
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adding source documents 38
checking associated files into 38
checking linked templates into 38
creating a project file 36
opening a project file 54
project setup in 35
Publish Status custom feature 52
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saving a project file 36

Folder Import wizard 7
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graphics formats supported 88

H
Help menu 8
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documents created in 80
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linked publication
adding to a project 58
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Microsoft PowerPoint, styles in 94
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no script support 78
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in compound document 40
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output
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staging 59

Output Character Set 78
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default 48
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passing through documents without conversion 91
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publication
defined 18
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Publication Properties dialog box 49
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S
Server menu 8
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source document
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a project 60
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output 59
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T
task list

explained 32
managing 32
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template

Blank 95
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defined 19
editing process 15
explained 16
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in Default.tcp 95
presentation 95, 97
reference page 95
spreadsheet 95, 97

Template menu 8
text formats supported 84
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large 9
standard 9

translating source documents 47
translation 91

passing through documents without conversion 91
specifying a Draft version 53
specifying a Publish version 51
specifying a version in a FileNet repository 52
specifying a version in FileNet Document Publisher 

Station 53
specifying the newest published version 51
using non-English versions of Word 80
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translation (cont’d)
what happens during 15
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Tutorial, access from Startup Screen 6

U
UNC path, importance of using 26
Unicode 78
Update Versions

and compound documents 50
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command 49, 50
dialog box 50
selecting documents to update 60

updating
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V
version of a source document, specifying 51
Version Properties, adding custom feature to 55
versioning the project file 24
View menu 7
Viewers menu 8
viewers, setting up 82

W
web browser, associating with FileNet Document 

Publisher Station 82
web page defined 18
web publication, defined 18
web site, defined 19
webmaster 17, 57
Windows 2000, default output directory when 
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Windows XP, default output directory when running 
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wizards

Add a Document 5
Folder Import 7

Word, translation source documents created in 
international versions 80

X
XML file as input file 90
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